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CAREWare 6 Overview

“‘CAREWare is a free, electronic health and social support services information system for
HRSA’s Ryan White HIV/AIDS Program recipients and providers. CAREWare was
developed by HRSA’s HIV/AIDS Bureau and first released in 2000.”

CAREWare 6 will run in an internet browser of your choice, except Internet Explorer.
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What You Need to Know About CAREWare 6

CAREWare 6 is different than CAREWare 5 in many ways. Here are some
things you need to know:

1. When you open a client record, it will open a new tab on your browser. Make sure you
close the record after entering in all necessary information. If you don't, it will keep the

record open in that tab even if you move on to a new client.

® custom
Demographi
Client Repo

Encounter Report

ize

Demographics

% Delete Ciient  Back

a

Drug Payments

Services
Annual Revi
Case Notes

iew

Custom Forms

Vital Signs

Hospital Admissions

Medications Detroit , Ml 48202
Labs
Screenings Race/Ethnicity White
Screening Labs
Immunizations
. HIV Risk Factors Heterosexual
Diagnoses
Sharing Requests
Referrals Vital Enroliment Status | Vital Status: Alive Current Status: Active
Relations
Counseling and Testing Eligibility Not Eligible for Ryan White
Pregnancy History
Orders
Hobbies. HIV Status. HIV-positive (AIDS status unknown) Estimated HIV Date: 02/12/2012

Custom Subform

Adherence

Appointments

Cap On Charges

User Messages
Search Change Details

Duplicate C
Performanc:
Status

lient
e Measure

@Demographics
Personal Info Name: Doolittle, Kimberly Gender: Female DOB: 02/12/1971

Change URN KMDO00212712U

2799 W. Grand Bivd

Contact Information

This is something everyone needs to know. For example:

Common Notes Preferred name

Address Change
Phone Number Change

Provider Notes No description supplied

Other Core Information | View or Edit the client's Other Core Information information

External Links

CW6 Special Info-mation | View or Edit the client's CW6 Special Info-mation information

2. You navigate the client’s record through the menu options located on the left-hand
side of the record. When you want to move from one tab to the other, simply click the
tab on the left-hand side. It will take you to that tab. For example, if you want to add a
case note, click it.

@ customize
Demographics
Client Report

Encounter Report
Drug Payments
Services
Annual Review
Case Notes
Custom Forms
Vitel Sigrs
Hospital Admissions
Medications
Labs
Screenings
Sereening Labs
Immunizations
Diagnoses.

Sharing Requests
Referrals

Relations

Counseling and Tasting
Pregnancy History
Orders

Hobbies

Custom Subform

Adherence
Appolntments
Cap On Charges
User Messages
Search Change Details
Duplicate Client
Performance Measure

status

External Links
Close

Revised December 2022

Demographics

Delete Client  Back

@Demographics

Personal Info

Change URN

Contact Information

Race/Ethnicity

HIV Risk Factors.

Vital Enroliment Status

Engioiny.

HIV Status.

Cormmon Notes

Provider Notes

Other Core Information

CW6 Special info-mation

Name: Doolittle, Kimberly Gender: Female DOB: 02/12/1971

KMDO0212712U

2799 W. Grand Bivd
Detroit , MI 48202

white
Heterosexual

Vital Status: Alive Current Status: Active
Not ENgible for Ryan White

HIV-positive (AIDS status unknown) Estimated HIV Date: 02/12/2012
This is something everyone needs to know. For example:
Prefened name

Address Change
Phone Number Change

No description suppiied

View or Edit the client's Other Core Information information

View or Edit the client's CW6 Special Info-mation information

GoTo Top of Document
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3. If you are in the middle of adding any record, whether it is a service, lab, etc., you
will not be able to access anything else. For example, if you are in the middle of
adding a screening lab and want to add a service, you must either:

e Add the current record and save it
e Click the Back button

@ Customize
Demographics
Client Report
Encounter Report
Drug Payments
Services

Annual Review
Case Notes
Custom Forms
Vital Signs
Hospital Admissions
Medications

Labs

Screenings
Screening Labs
Immunizations
Diagnoses
Sharing Requests
Referrals
Relations

Find Client = Search Results > Demographics > Screenings > Add

Save Back

Add

Test Date: |8/2/2019

Test Definition:

Result:

Action:

Test Score:

Test Comments:

If you try to access the menu on the left-hand side without doing one of the two things
listed above, nothing will happen.

4. The Customize link allows you to configure the available menu items you see on
the left-hand side. It is not recommended to customize the menu; instead, leave
all of the options available. That way, you don’t have to worry about leaving out a
menu item that you may need in the future.

9 Customize
Demographics
Client Report

Encounter Report

Drug Payments
Services
Annual Review
Caszea Notes
Custom Forms
Vital Signs

Hospital Admissions

Medications
Labs
Screenings
Screening Labs
Immunizations

Revised December 2022

Find Client > Search Results > Demographics > Customize menu items

Back

Customize menu items

Personal Menu Settings

Provider Group Settings

Central Group Settings

Configure the available menu items for you

Configure the available menu items for members of user groups that are administered by
Kevin's Clinic

Configure the available menu items for members of user groups that are administered by
Central Administration

GoTo Top of the Document
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How To Add a Client

1. Select Add Client A new tab will open.

2. Enter the Last Name,
must be completed in order to add the client.

Department of Health and Human Services

GRS

Health Resources and Services Administration

gowens > Kevin's Clinic

D customize
Add Client

Find Client
Reports

Rapid Entry
Appointments

My Seftings
System Information
System Messages
Administrative Options
Switch Providers
Log Off

This is a test notification

3. Click Add.

1.

Select Find Client.

First Name, Middle Name, Gender, and Date of Birth. All fields

How To Find a Client

Department of Health and Human Services

I

ekl el
":,J’.I_|;|-&w

Health Resources and Services Administration

@ Customize
Add Client

Find Client

Reports

Rapid Entry
Appointments

My Settings
System Information
System Messages
Administrative Options
Switch Providers
Log Off

This is a test notification

2. A new tab will open. Enter the Last Name and First Name, or Client ID/URN.
3. 3.Select Client Search.

Revised December 2022
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This is the Demographics Page-Main Page

Demographics

Delete Client Back
@Demographics

Personal Info Name: Doolittle, Kimberly Gender: Female DOB: 02/12/1971

Change URN KMD00212712U
Vital Signs
Hospital Admissions

S — 2799 W. Grand Bivd

Detroit , Ml 48202

Vital Enroliment Status Vital Status: Alive Current Status: Active

Eligibility Not Eligible for Ryan White

HIV Status HIV-positive (AIDS status unknown) Estimated HIV Date: 02/12/2012

ore Information View or Edit the client’s Other Core Information information

CW6 Special info-mation View or Edit the client’s CW6 Special Info-mation information

This page holds all of the basic client information. Here are a few things you need to
know:

« Once you add a client, you cannot change the First Name, Last Name, Gender,
or Date of Birth. If one of these fields need to be changed, you must contact the
CAREWare data team.

- In order to add any records (such as Race/Ethnicity, HIV Risk Factor, or Contact
Information) you must click the blue lettered tabs of the category you wish to edit
(located in the middle of the page).

- All information on the demographic page is displayed next to the blue lettered
tabs.

- Common notes are not permanent and can be viewed, edited, or deleted by
anyone who has access to the client record. Therefore, common notes should
only be used when it is something you want everyone to know about the client. If
you want to enter something that will be permanently saved in CAREWare or is
personal to the client, then enter it into Case Notes.

- Everything on the demographics page, with the exception of custom tabs,
eligibility status, case notes, and enrollment date and status, is shared with other
providers that are also providing services to the client and can be changed by
those providers.

- Custom tabs are now located on the demographics page.
- The left-hand side is how you will navigate all of the tabs of the client’s record.

GoTo Top of the Document
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How to Add Information to the Demographics Page

1. From the main page, you can add, view, and edit various demographic information.
To add or edit information, click the blue lettered tab of the category you wish to
view or edit.

® . Find Client > Demographics
Customize

Demographics Delete Client Back

Client Report

Encounter Report
Drug Payments
Services

Annual Review
Case Notes
Custom Forms
Vital Signs
Hospital Admissions
Medications

Labs

Scresnings
Screening Labs
Immunizations
Diagnoses
Sharing Requests
Refarrals
Relations
Counseling and Testing
Pregnancy History
Orders

Hobbies

Custem Subform
Adherence
Appointments
Cap On Charges

@®Demographics

Personal Info

Change URN

Contact Information

Race/Ethnicity

HIV Risk Factors

Vital Enroliment Status

Eligibility

HIV Status

Common Notes

Name: Doolittle, Kimberly Gender: Female DOB: 02/12/1971

KMDO0212712U

2799 W. Grand Bivd
Detroit , MI 48202

White

Heterosexual

Vital Status: Alive Current Status: Active

Not Eligible for Ryan White

HIV-positive (AIDS status unknown) Estimated HIV Date: 02/12/2012

This is something everyone needs to know. For example:

Preferred name
Address Change
Phone Number Change

User Messages
Search Change Details
Duplicate Client

Performance Measure
Status Other Core Information

Provider Notes No description supplied
View or Edit the client’s Other Core Information information
External Links

Close CW8 Special Info-mation View or Edit the client’s CW6 Special Info-mation information

2. The tab will open. Enter all relevant information

3. Save
Contact Information
Note: L=
. . County: fame
Some information has to
. Phone: (3139165266
be entered using a drop- et
down menu. If a category
has a drop-down menu
next to |t,.
Phone Type (Alt, Phone 2):

you must choose from the
list provided.

After you save, you will be taken back to the main page. You can view and edit other
categories by clicking the blue tab of the category you wish to view and follow the same
instructions. Some categories will require you to enter data while others will require you

to check the appropriate box.
GoTo Top of the Document
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discharged from your agency or become
reflect that. If enrollment or vital status changes, follow these

How To Edit Enroliment Status

When you add a client to CAREWare, the enroliment status will automatically be Active
and vital status will be Alive. However, that information could change. The client may be

inactive. You will need to add a record to
instructions:

1. Open a client record. Enroliment Status is located on the demographics page.

2. Select Vital Enrollment Status.

@ Customize
Demographics
Client Report
Encounter Report
Drug Payments
Services

Annual Review
Case Notes
Custom Forms
Vital Signs
Hospital Admissions
Medications

Labs

Screenings
Screening Labs
Immunizations
Diagnoses
Sharing Requests
Referrals
Relations
Counseling and Testing
Pregnancy History
Orders

Haobbies

Custom Subform
Adherence
Appointments
Cap On Charges
User Messages
Search Change Details
Duplicate Client

Performance Measure
Status

External Links
Close

Demographics

Delete Client Back

@®Demographics

Personal Info

Change URN

Contact Information

Race/Ethnicity

HIV Risk Factors

Vital Enroliment Status

Eligibility

HIV Status

Common Motes

Provider Notes

Cther Core Information

CW8 Special Info-maticn

Name: Doolittle, Kimberly Gender: Female DOB: 02/12/1971

KMDO0212712U

2799 W. Grand Blvd
Detroit, MI 48202

White

Heterosexual

Vital Status: Alive Current Status: Active

Not Eligible for Ryan White

HIV-positive (AIDS status unknown) Estimated HIV Date: 02/12/2012

This is something everyone needs to know. For example:

Preferred name
Address Change
Phone Number Change

No description supplied

View or Edit the client’s Other Core Information information

View or Edit the client's CW6 Special Info-mation information

3. Enter the NEW Enrollment or Vital Status. Choose from the dropdown menu.

4. Save.

@ Customize
Demographics
Client Report

Encounter Report

Drug Payments
Services
Annual Review
Case Notes
Custom Forms
Vital Signs

Hospital Admissions

Medications
Labs

Find Client = Search Resuits > Demographics > Vital Enrollment Status

Save

Cancel

Vital Enrollment Status

Latest Eligibility Status:

Enrollment Date:

Case Closed Date:

Enroliment Status: |Referred or Discharged

|2r26/2008

R-,.'_an White Eligible

Vital Status: |Alive

08/30/2019

Date of Death:

Note: When you change enrollment status from active, you will be prompted to enter a
Case Closed Date.

You will also be prompted to enter a Date of Death if you change vital status to

deceased.

Revised December 2022
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How To Add Eligibility Records

If a client has ever received a Ryan White funded service (Part A, B, C, D), they must
be marked as Ryan White Eligible. This has to be done at the time of the first Ryan

White funded service.

When you add a client to CAREWare, the default status will always be “Not Eligible for
Ryan White.” Therefore, every time you add a new client, you must create a record
that documents the eligibility status. To document eligibility, follow the instructions

below:

1. Open the client record. Eligibility is located on the demographics page.

2. Select Eligibility.

Note: You can find out if a
client has any eligibility
records by looking at
the information next
to Eligibility. For more
details, click eligibility.
It will show you a
history of all records.

@ cusiomize
Demagraphics
Client Report
Encaunter Report
Drug Payments

Referrals
Relations

Demographics

Delete Client  Back

®Demographics

Personal Info

Change URN

Contact Information

Race/Ethnicity

HIV Risk Factors

Vital Enroliment Status

Name: Doolittle, Kimberly Gender: Female DOB: 02/12/1971

KMDO0212712U

2799 W. Grand Bivd
Detroit, MI 48202

White

Heterosexual

Vital Status: Alive Current Status: Active

Counseling and Testing Eligibility Not Eligible for Ryan White
Pregnancy History
Orders
Hobbies HIV Status HIV-positive (AIDS status unknown) Estimated HIV Date: 02/12/2012
Custom Subform
Adherence This is something everyone needs to know. For example:
Appointments Common Notes
Cap On Charges
= Provider Notes No description supplied
P: us Other Core Information 'View or Edit the client's Other Core Information information
Clos CWB Special Info-mation | View or Edit the client's CWG Special Info-mation information
3. Select Add.
@ . Find Clignt» Demographics » Eligibility
Customize
Demographics View Add Edt Delete Back Printor Export
Client Repart e .
Encounter Report E“glblllty HIStOI'y
Drug Payments
arey Search:
Services Z
Annual Review Date Is Eligible Funding Source Ryan White Funded Comment Client Documents Enrollment End Dz Eligibility Docume
Case Notes

4. Enter the Eligibility Date, Eligibility Status, & Funding Source.

Revised December 2022
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5. Select Save.

@ Clistormise Find Client > Search Results > Demographics > Eligibility > Add
Demographics Save Cancel

Client Report

Encounter Report Add

Drug Payments -

Sanicos Eligbility Date: |4/1/2019 H

Annual Review Is Eligible: |Yes

gji?o::oizims Funding Source: FartA
Vital Signs Comment:

Hospital Admissions
Medications

Labs

Screenings
Screening Labs
Immunizations
Diagnoses

6. Once you save the record, the client will be marked as eligible.

@ > Find Client = Search Results > Demographics > Eligibility
Customize

Demographics View  Add Edit Delete Back Print or Export

Client Report e -

EioLumEeE R Eligibility History

Drug Payments Soarch

Services ==

Annual Review Date Is Eligible Funding Source Ryan White Funde Comment
Case Notes 04/01/2019 Yes Fart A

Yes
Custom Forms

Clients may receive Ryan White funding from multiple sources. An eligibility record must
be created for each funding source in which the client is being served. Once you add a
record, CAREWare will create a history that will allow you to track all funding sources
over time.

Discharging a Client

1. When a client is DISCHARGED from your agency and you enter a case closed date,
you will need to update the eligibility status records. You must enter a NEW record
that marks the client as NOT eligible for the funding source.

2. Do not edit any previous eligibility records; just add a new record. If you adjust old
records, it may appear that you provided services to someone who was not eligible.
YOU DO NOT WANT THIS.

3. When you return to the demographics page, the client record will be updated.

GoTo Top of the Document
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How To Add Case Notes

1. Open the client record.

2. Select Case Notes from the menu of links on the left-hand side of the record.

@ customize
Demographics
Client Report
Encounter Report
Drug Payments
Services

Annual Review
Case Notes
Custom Forms
vital Signs
Hospital Admissions
Medications

Labs

Screenings
Screening Labs
Immunizations
Diagnoses
Sharing Requests
Referrals
Relations
Counseling and Testing
Pragnancy Histary
Orders

Hobbies

Custom Subform
Adherence
Appointments
Cap On Charges
User Messages
Search Change Details
Duplicate Client

Performance Measure
Status

External Links
Close

Q Customize
Demographics
Client Report
Encounter Report
Drug Payments
Insurance Services
Annual Review
Case Notes
Custoem Forms
Vital Signs
Hospital Admissions
Medications

Labs

Screesnings
Screening Labs
Immunizations
Diagnoses

Sharing Requests
Referrals
Relations

Counseling and Testing

Pregnancy History
Crders

Adherence
Appointments
User Messages

Search Change Details

Duplicate Client

Performance Measure

Status
External Links
Close

Revised December 2022

Find Client > Demographics

Delete Client Back

@Demographics

Personal Info

Change URN

Contact Information

Race/Ethnicity

HIV Risk Factors

Vital Enroliment Status

Eligibility

HIV Status

Common Notes

Provider Nofes

Other Core Information

CW6 Special Info-mation

3. Select Case Note Entry.

Name: Doolittle, Kimberly Gender: Female DOB: 02/12/1971

KMDO0212712U

2799 W. Grand Bivd
Detroit , Ml 48202

White

Heterosexual

Vital Status: Alive Current Status: Active

Not Eligible for Ryan White

HIV-positive (AIDS status unknown) Estimated HIV Date: 02/12/2012

This is something everyone needs to know. For example:

Preferred name
Address Change
Phone Number Change

No description supplied

View or Edit the client's Other Core Information information

View or Edit the client's CW6 Special Info-mation information

Find Client > Demographics > Case Notes

Back

@Case Notes

Case Note Entry

Enter a new case note for the client

Case Note Repori

Run a report on case notes entered for this client

GoTo Top of the Document
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4. Select Add.

@ Customize
Demographics
Client Report
Encounter Report
Drug Payments
Insurance Services
Annual Review
Case MNotes
Custom Forms
Vital Signs
Hospital Admissions
Medications

Labs

Screenings
Screening Labs
Immunizations
Diagnoses

Sharing Requests
Referrals
Relations

Find Client ®» Demographics » Case Notes » Case Note Entry

View Add Add With Templates Delete
Case Notes

Search:

Date : Provider Author

Manage Templates

Case Note

5. Enter the Date of service and Author name (if applicable).

6. Enter Case Note.

7. Save.

@ Customize
Demographics
Client Report
Encountsr Report
Drug Payments
Insurance Services
Annual Review
Case Notes
Custom Forms
Vital Signs
Hospital Admissions
Medications

Labs

Screenings
Screening Labs
Immunizations
Diagnosas
Sharing Requests
Referrals

Relations
Counseling and Testing
Pregnancy History
Orders

Find Client > Demographics > Case Notes > Case Note Entry > Add

Save Back

Add

Date: .

Add Service:
Author: .

Case Note: |

Help

Back

Print or Export

Note: If you select the Add Service box, you will be directed to the services tab where
you can enter the service for the client. This is a short cut to adding a service.

Revised December 2022
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How To Add a Service

1. Open a client record. Select the Services tab from the menu of links on the left-hand
side of the client record.

@ Customize
Demographics
Client Report
Encounter Report
Drug Payments
Services

Annual Review
Case Notes
Custom Forms
Vital Signs
Hospital Admissions
Medications
Labs

Screenings
Screening Labs
Immunizations
Diagnoses

2. Select Add.

@ Customize
Demographics
Client Report
Encounter Report
Drug Payments
Senvices

Annual Review
Case Notes
Custom Forms
Vital Signs
Hospital Admissions
Medications

Labs

Streenings
Streening Labs
Immunizations
Diagnoses
Sharing Requests
Refarrals
Relations

Find Client > Demographics

Delgte Client  Back

®Demographics

Personal Info

Change URN

Contact Information

Race/Ethnicity

HIV Risk Factors

Name: Doolittle, Kimberly Gender; Female DOB: 0211211971

KMDO0212712U

2799 W. Grand Blvd
Detroit, Mi 48202

White

Heterosexual

Find Client > Search Results > Demographics » Services

View Add Delete

Receipts  Help  Print or Export

Services

Search:|

Date Subservice Contract Units
120572014 MCM Face-to-face  First Contract 1
111972014 Mental Health Scre¢ First Contract 1
111712014 Mental Health Scre¢ First Contract 1
1172014 Nurse Visit First Contract 1
1704 MCM Face-to-face  First Contract 1
1172014 Non MCM First Contract 1

1172014 Dental Cleaning  First Contract 1

Revised December 2022

Price
50.01
50.01
50.01
50.00
51.00
5001
51.00

Total
50.01
50.01
50.01
50.00
51.00
50.01
51.00

Amount Received Provider

50.00
50.00
50.00
50.00
50.00
50.00
50.00

Kevin's Clinic
Kevin's Clinic
Kevin's Clinic
Kevin's Clinic
Kevin's Clinic
Kevin's Clinic

Kevin's Clinic

GoTo Top of the Document
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3. Enter the Date the service was provided and select the Service Name from the

subservice drop-down list.

g Customize
Demaographics
Client Report

Encounter Report Add

Drug Payments

Next Back

Services Client: |Kimberly Doolittle

Annual Review Date: |8/20/2019 E
Case Not
ase fotes Service Name: |Food Bank/Home-delivered Meals
Custom Forms

Vital Signs

Hospital Admissions

Medications

Find Client > Demographics > Services = Add Service

Note: You cannot scroll through the drop-down menu. Therefore, if you need to add a
service that doesn’t immediately appear when you click the drop-down menu, enter
the first couple of letters in the search box. From there, you can select the correct

service.

4. Once you enter the date and service, click Next. This will take you to the next phase of

adding a service.

Find Client = Demographics = Services » Add Service

Next Back

@ Customize
Demographics
Client Repart

Encounter Report Add
Drug Payments

Services

Annual Review Date: (82012019 J
Case Nofes

Custom Forms

Vital Signs

Hospital Admissions

Medications

Client; |Kimberly Dooiitle

Service Name; |Food Bank/Home-delivered Mezls
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5. Enter the correct Contract and Units.

6. Save

@ Customize
Demographics
Client Report
Encounter Report
Drug Payments
Services

Annual Review
Case Notes
Custom Forms
Vital Signs
Hospital Admissions
Medications
Labs

Sereenings

Find Client > Demographics » Services » Add Service » Add Service

Save  Back

Next

Client: |[Kimberly Doolittle
Date; (82012019

Service Name: |Food Bank/Home-delvered Meals

Confract: Part A

nits: |1
Price: |0.00 |5
Total: [0.00 §

7. If you need to edit a service, select the service that needs editing and then click View.
From there, you can edit the service by selecting Edit.

Q Customize
Demographics
Client Report
Encounter Report
Drug Payments
Services

Annual Review
Case Notes
Custom Forms
Vital Signs
Hospital Admissions
Medications

@ Customize
Demographics
Cliznt Report
Encounter Report
Drug Payments
Services

Annual Review
Case Notes
Custom Forms
Vital Signs
Hospital Admissions
Medications
Labs

Screenings

Find Client » Demographics » Services

View Add Delete Receipts Help Print or Export

Services

Search:

Date Subservice Contract Units Price Total
08/20/2019 Food Bank/Home-delivered M Part A 1 §0.00 §0.00
06/03/2019 Medical Case Management  Part A 2 50.00 50.00

Find Client> Demographics > Services > View

Edit Recelpts Back

View
Provider: |Kevin's Clinic
Date: (812072019
Service Name: |Food Bank/Home-defivered Meals

Contract: |PartA

Units: |1
Price: |0.00 3
Total: |0.00 5

8. After you have completed your edits, click Save.

Find Client > Search Results > Demographics > Services > View > Edit

Save

Cancel

Revised December 2022

Amount Received Provider

§0.00
$0.00

Service Comment Cognitivi
Kevin's Clinic

Kevin's Clinic

GoTo Top of the Document

Page 15



How to Navigate the Annual Review Tab

Annually, CAREWare users are required to review and update a series of fields. These
include the following:

- Insurance

« Federal Poverty Level

+ Housing Arrangement

- HIV Risk Reduction Counseling

« Mental Health and Substance Abuse Screenings
« HIV Primary Care Visits

The three bolded fields are RSR-required and must be completed for any client who
received a Ryan White funded service during the reporting year.

Entering Annual Review Data

1. Open a client record. Select the Annual Review tab from the menu of links on the left-
hand side of the client record.

2. Select the field in which you would like to add a record.

9 B Find Client = Search Results > Demographics = Annual Data
Customize

Demographics
Client Report
Encounter Report @An nual Data
Drug Payments
Services
Annual Review Annuzl Screenings View or Edit the client’s Annual Screenings

Back

Case Notes
Custom Forms

Vital Signs

Hospital Admissions

Insurance Assessments \View or Edit the client's Insurance Assessments

Modicatinns Foverty Level Assessmenis WView or Edit the client’s Poverty Level Assessmenis

Labs

Screenings Annual Custom View or Edit the client's Custom Annual data
Screening Labs

3. Select Add

@ Customize Find Client > Search Results > Demographics > Annual Data > Annual Screenings
u L

Demaographics View Add Edit Delete Back Help Print or Export

Client Report

Annual Screenings

Encounter Report
Drug Payments

Search:

Services =
Rnn- F o e Date Type Result Counseled By
Case Notes 12131/2011 Mental Health Yes
Custom Forms 12/31/2011 Substance Abuse Yes
Vital Si

s L 1213172011 HIV Risk Reduction Counseling Yes
Hospital Admissions )
Medications 12/31/2011 Housing Arrangement Stable/Permanant
Fobhe 12/231/2011 HIV Primary Care Hospital outpatient «
Screenings 121312010 HIV Primary Care Hospital outpatient «

4. Enter the Date, and select Type, Result, and Counseled By (if applicable).

GoTo Top of the Document
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5. Save.

@ Cislomize Find Client > Search Results > Demographics > Annual Data > Annual Screenings > Add

Demographics Save Cancel

Client Report

Encounter Report Add

Drug Payments .

Services Date: |8/1/2019

Annual Review Type: HIV Risk Reduction Counseling

Casze Notes .
Result: |Yes +

Custom Forms .

Vital Signs Counseled By: |Primary care clinician

Hospital Admissions

Medications

Labs

6. If you need to edit an annual review record, select the record in which you would like to
edit and then select Edit.

@ i Find Client » Search Results > Demographics > Annual Data > Annual Screenings
Customize

Demographics View Add Edit Delete Back Help Printor Export

Client Report

Annual Screenings

Encounter Report
Drug Payments

Search:

Semvices =
Annual Review Date Type Result Counseled By
Case Notes 0&/01/2019 HIV Risk Reduction Counseling Yes Primary care cliniciz
Custom Forms 1213112011 HIV Risk Reduction Counseling Yes
Vital Signs

: ¢ 5 121312011 Mental Health Yes
Hospital Admissions

¥i

Madications 123172011 Substance Abuse Yes
Labs 127312011 Housing Arrangement Stable/Permanent
Screenings 12312011 HIV Primary Care Hospital outpatient 1

B e

That will take you back to the field and will allow you to make all the necessary changes.
After making the changes, select Save.

Note: CAREWare 6 works by navigating tabs, and there are tabs within tabs. If you
need to navigate while in a tab, you will need to use the subtabs. Below is what
a subtab looks like. Click the back or next button in order to move through the
different phases.

@ : I Find Client > Search Results > Demographics > Annual Data > Annual Screenings I
Customize

Demographics View Add Edit Delete Back Help Printor Export

Client Report

Annual Screenings

Encounter Report

n -
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How To Add a Medication

1. Open a client record. Select the Medications from the menu of links on the left-hand
side of the client record.

medications. To add or edit a medication, select All (Start, Stop, Change).

@ Customize
Demographics
Client Report
Encounter Report
Drug Payments
Services

Annual Review
Case Notes
Custom Forms
Vital Signs
Hospital Admissions
Medications

Labs

Screenings
Screening Labs
Immunizations

3. Select Start.

@ Customize
Demographics
Client Report
Encounter Report
Drug Payments
Services

Annual Review
Case Notes
Custom Forms
Vital Signs

Find Client > Search Resulis > Demographics > Client Medications

Back
@Client Medications

Allergies and ART

| All (Start, Stop, Change) 2 medication records entered I

Sustiva (efavirenz) (10/26/2009), Epivir (lamivudine) (10/26/2009)

ART First Prescribed: 10/26/2009No medication allergies recorded

Current Medications

Past Medications Mo description supplied

Find Client > Search Results > Demographics > Client Medications » All (Start, Stop, Change)

View Start Start Regimen Stop Delete Back  Print or Export

All Medications

Search: |

Medication Name Abbreviation Form Units Strength (mg) Dose Frequency
Sustiva (efavirenz) EFV 1 1 1 Once a day (gd)
Epivir (lamivudine) 3TC 1 1 1 Once a day (gd)

You can view the client’s current medications, past medications, allergies, and add new

Total Dose
1
1

4. From the drop-down menu, select the Start Date, Medication Name, Units, Form,
Strength, Frequency, Indication and comments (if necessary).

5. Save.

@ Customize
Demographics
Client Report
Encounter Report
Drug Payments
Services

Annual Review
Case Notes
Custom Forms
Vital Signs
Hospital Admissions
Medications

Labs

Screenings
Screening Labs
Immunizations
Diagnoses
Sharing Requests
Referrals
Relations

Find Client = Search Results > Demographics > Client Medications = All (Start, Stop, Change) > Start

Save Back

Start

Start Date: |7/1/2019 ﬁ

Medication Name: Vitekta (elvitegravir)
Units:
Form: |Chewsble Tablets g
Strength: 20 | mg

Frequency: Every 12 hours {g12h)

Co

Indication: ART
Ol
Comment: Use th-is. i.I' necessary

Instructions:

GoTo Top of the Document
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How To Edit a Medication

1. If you need to edit a medication, select the medication you would like to change and

click View.

@ Customize
Demographics
Client Report
Encounter Report
Drug Payments
Services

Annual Review
Case Notes
Custom Forms
Vital Signs
Hospital Admissions
Medications

Find Client> Search Results > Demographics > Client Medications » All Medications

View Start StartRegimen Stop Delete Back Print or Export

All Medications

Search: |

Medication Name Abbreviation Form Units Strength (mg) Dose Frequency Total Dose Indication
Sustiva (efavirenz) EFV 1 1 1 Onceaday (gd) 1 ART
Epivir {lamivuding) 3TC 1 1 1 Onceaday (gd) 1 ART
Vitekta (elvitegravir] ELV Chewable Tablets 1 20 20 Every 12 hours (q1: 40 ART

2. From there, you can either correct a data error or change the dose.

3. Either select Correct Data Error or Change Dose.

@ Customize
Demographics
Client Report
Encounter Report
Drug Payments
Services

Annual Review
Case Notes
Custom Forms
Vital Signs
Hospital Admissions
Medications

Q Customize
Demographics
Client Report
Encounter Report
Drug Payments
Semvices

Annual Review
Case Notes
Custom Forms
Vital Signs
Haospital Admissions
Medications

Find Client > Search Results > Demographics > Client Medications > All Medications > View

Correct Data Error  Change Dose  Back

View
Start Date: 73’1.’2_019
Medication Name: _Viiek‘ta {elvitegravir)
Units; |1
Form: |Chewable Tablets

Strength: |20 mg

Find Client> Search Results > Demographics > Client ications > All ications > View

Correct Data Error  Change Dose  Back

View
Start Date: |7/1/2019
Medication Name: |Vitekia (elvitegravir)
Units: |1
Form: |Chewable Tablets

Strength: |20 mg

4. Once you make all of the necessary changes, Save the record.

e Customize
Demographics
Client Report
Encounter Report
Drug Payments
Services

Annual Review
Case Notes
Custom Forms
Vital Signs
Hospital Admissiens
Medications
Labs

Screenings
Screening Labs
Immunizations

Find Client > Search Results > Demographics > Client Medications > All Medications > View > Change Dose

Save Cancel

Change Dose

Change Date: (8/1/2019
Medication: elvitegravir

Current Units: |1

Current Strength: 20 mg
Current Frequency: Every 12 hours (g12h)
New Units:
New Strength: 50 mg
rew Frequency; |Every & hours (g6h)

GoTo Top of the Document
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How To Add a Lab/Screening Lab/Screening

1. Open a client record. Select Labs or Screening Labs or Screenings from the menu of
links on the left-hand side of the client record. Each is a different tab, but the
information is entered the same way.

@ 5 Find Client > Search Results > Demographics > Labs
Customize

Demographics View Add Delete HLY Source Help  Print or Export
Client Report

Encountar Report Labs
Drug Payments
Services 7 -
Annual Review Date Test Name Test Operator Test Result Assay Provider Comment 1
Case Notes 01/04/2018 Viral Load = 20 Kevin's Clinic

Custom Forms

Vital Signs

Hospital Admissions

Medications

Labs

Screenings

Screening Labs

Search: |

2. Click Add.

Find Client > Search Results > Demographics > Labs

View Add Delete HLT Source Help Printor Export

@ Customize
Demographics
Client Report

Encounter Report Labs

Drug Payments Search:|

Services z

Annual Review Date Test Name Test Operator Test Result Assay Provider Comment B |
Case Notes 01/04/2018 viral Load = 20 Kevin's Clinic

Custom Forms

Vital Signs

Hospital Admissions
Medications

Labs

Screenings
Screening Labs
Immunizations

3. Under the drop-down menu, select the appropriate lab, test operator, and the result.
4. Save.

@ - Find Client > Search Results > Demographics > Labs > Add
Customize

Demographics Save Back
Client Report
Encounter Report Add
Drug Payments L =2
Services Date: |B/8/2019 )
Annual Review Lab: [CD4 Count
Case Notes T .
Test Operator: |= =
Custom Forms o . )
Vital Signs Test Result: [252 (cells/imm*)

Hospital Admissions
Medications

Labs

Screenings
Screening Labs
Immunizations
Diagnoses

Sharing Requests
Referrals

Relations

Comment: |Only add a comment if necessary |

Note: You cannot scroll through the drop-down menu. In order to access the necessary
lab, type in the first couple of letters of the lab in the search box.

GoTo Top of the Document
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How To Navigate a Custom Tab/Field

Some agencies utilize custom tabs. In CAREWare 6, custom tabs are the last three links
at the bottom of the demographics page. However, the names of the tabs have not
changed. Therefore, the name in CAREWare 6 will be the same name that was in

CAREWare 5.

If your tab was never given a name, then the default name will be Custom Tab 1, Custom
Tab 2, or Custom Tab 3.

@ Customize
Demographics
Client Report
Encounter Report
Drug Payments
Services

Annual Review
Case Notes
Custom Forms
Vital Signs
Hospital Admissions
Medications

Labs

Screenings
Screening Labs
Immunizations
Diagnoses
Sharing Requests
Referrals
Relations
Counseling and Testing
Pregnancy History
Orders

Hobbies

Custom Subform
Adherence
Appointments
Cap On Charges
User Messages
Search Change Details
Duplicate Client

Performance Measure
Status

External Links
Close

Find Client > Demographics

Delete Client Back

@Demographics

Personal Info

Change URN

Contact Information

Race/Ethnicity

HIV Risk Faciors

Vital Enroliment Status

Eligibility

HIV Siatus

Common Notes

Provider Nofes

Other Core Information

CW6 Special Info-mation

Linkage

Name: Doolittle, Kimberly Gender: Female DOB: 02/12/1971

KMDO0212712U

2799 W. Grand Bivd
Detroit , MI 42202

White

Heterosexual

Vital Status: Alive Current Status: Active

Not Eligible for Ryan White

HIV-positive (AIDS status unknown) Estimated HIV Date: 02/12/2012

This is something everyone needs to know. For example:

Preferred name

Address Change

Phone Number Change

No description supplied

View or Edit the client’'s Other Core Information information

View or Edit the client's CW6 Special Info-mation information

View or Edit the client’s Linkage information

Every custom tab will look different, but the way you enter a record will be the same.
Just remember the following:

1. If a custom tab has a drop-down menu, you must select a field from that menu.

2. You cannot scroll through the drop-down list. Therefore, type in the first couple of
letters of the field name and it will appear.

3. If a custom tab requires a check mark, all you have to do is check the appropriate

box.

4. If you want to close out of a custom tab before completion, simply click Cancel.
That will take you back to the demographics page of that client’s record.

Revised December 2022
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How To Enter a Custom Tab/Field Record

1. Click the custom tab that you need to access.

2. Click Edit.

® ) Find Client> Demographics
Customize

Demographics Delete Client  Back
Client Report
Farouata; Sane @®Demographics
Drug Payments
Services
berly Gender: Female DOB: 02/1211971

Annual Review Personal Info Name: Doolittle,
Case Notes —_
Custom Forms

Vital Signs

Hospital Admissions
Medications

Labs

Sereenings Race/Ethnicity White
Screening Labs S ——
Immunizations

Diagnoses

Sharing Requests

Change URN KMDO0212712U

99 W. Grand Blvd

Contact Information e e

11V Risk Factors

eterosexual

Referrals Vital Enroliment Status Vital Status: Alive Current Status: Active
Relations

Cormssimg andilssting Eiigibility Not Eligible for Ryan White

Pregnancy History

Orders

Hobbies HIV Status HIV_positive (AIDS status unknown) Estimated HIV Date: 02/12/2012

Custom Subtorm = - s = .
to 3 5

Al branie is is something everyone needs to know. For example:

Appointments common Notes Preferred name

Address Change

Cap Ol b ey hone Number Change

User Messages

Search Change Details Provider Notes. No description supplied

Duplicate Client —————

Performance Measure .

Status Other Core Information View or Edit the

External Links

nt's Other Core Information information
Close ©WB8 Special Info mation View or Edit the client's CW6 Special Info-mation information

= Linkage View or Edit the client’s Linkage information

® . Find Client > Demographics > Other Core Information
Customize

Demographics. Edit Back

Client Report

Encounter Report Other Core Information

Drug Payments

Soafvican Client Documents: 0 Attachments (Access in view mode only)
Annual Review Preferred Name:

Case Notes
Custom Forms

Vital Signs

Hospital Admissions
Medications

Labs igibili a (Access in view mode only)

Screenings
Screening Labs
Immunizations
Diagnoses
Sharing Requests
Referrals
Relations
Counseling and Testing |

testmemo:

Pregnancy History

Orders

Hobbiss hyperiink: NURS:Www.000

Custom Subform MD EVS Site:  hitps: t 4 .
Adherence =

! Agency Case Manager:
Appointments

Cap On Charges

3. Add all of the necessary information.
4. Save.

® Find Client > Demographics > Other Core Information
Customize

Demagraphics | Save Cancel
Client Report

Encounter Report Other Core Information
Drug Payments
Services
Annual Review Preferred Name: | Preferred neme is
Case Noles

Custom Forms

Vital Signs

Hospital Admissions at
Medications

Labs

Sereenings

Screening Labs
Immunizations
Diagnoses

Sharing Requests
Referrals

Relations

Counseling and Testing
Pregnancy Histary
Orders

Hobbies

Custom Subform MD EVS Site:
Adherence

Appointments.

cl

t Documents: 0 Attachments (Access in view mode only)

0 Attachments (Access in view mode only}

hyperiin

https:www google.com/

Agency Case Manager: |Genna Owens
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Adding Attachments

Space has been created in CAREWare within the Annual Review tab to store PDF
attachments with the primary purpose of reducing the burden of documenting Ryan White
eligibility. There are five categories/folders:

Income Documentation

Insurance Documentation

Residency Documentation

Status Documentation

Miscellaneous Documentation (ex. License, lab report, etc.)

Think of attachments like any other information in the annual review tab. Other providers
that serve the same client will have access to this information. Additionally, anyone
serving that client can delete the attachments regardless of who added them into
CAREWare. Therefore, please do not delete any attachments that are not your own.

Attachments Parameters
File Type: PDF files are the only file type supported in these folders.

Number of Attachments: Each Provider may upload two attachments per category for
each year. This means that you may upload two income documentation attachments and
two insurance documentation attachments every year; however, if you want to upload a
third in any category, then you must delete one of your previous two. Keep in mind that
some clients are served by multiple providers, so there may be more than two in each
category as each provider may upload two.

Page Limit for Attachments: Each PDF should be no more than three pages.

File Naming: In order to keep things consistent across providers, include your agency
name and the document name in your title. The date of the upload is automatically provided
in the description, so it isn’t necessary in the file name. Here are a few examples:

Income WSU Adult
March 2019 Income WSU Adult
HIV Status Matrix

Using Attachments for Eligibility: Providers may use documentation from other providers
to prove eligibility. However, an attachment could accidentally be deleted, so we strongly
recommend that you save a copy elsewhere. For example, let's say WSU Adult is serving a
client and is getting ready for reassessment. They can see that HELP has already
assessed and uploaded proof of residency and income. Because an updated income
document has already been uploaded, WSU can utilize that information for their
reassessment as well. We would advise that WSU Adult download those documents and
save in their client record.

GoTo Top of the Document
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Deleting Attachments: Only delete attachments that were uploaded by your agency.
If you have a question about one of the attachments, contact MDHHS — Bureau of
HIV/STD Programs (MDHHS-SHOARS-SUPPORT@michigan.gov), or the provider
that uploaded the attachment. Once a document is deleted, it cannot be recovered.

Uploading Attachments (Basic Overview)

1. Login to CAREWare.
2. Select Find Client and search for the correct one.

3. Once the client file is open, select Annual Review from the menu of links on the left-
hand side.

4. Select Annual Custom.

5. From there, you have a few options. More than likely, the page will be blank, which
means you will need to add the year in order to add an attachment. If the year is
already there, then you can select View. However, if there is no year, select Add.

6. Select the current year. Then select Save.

7. Double-click the year again. Everything will be grayed out. (It is supposed to look like
that, so don’t be alarmed). Do not select edit. Instead, select the category that you
want to add an attachment (ex. HIV Status Documentation).

8. Select Add.
9. Select Choose Files and choose the correct file. Again, make sure it is a PDF.

10. After selecting the file, make sure it says Upload Completed Successfully. Then select
Next.

11. Under content type, select PDF from the drop-down menu. You can also add a
comment.

12. Select Save.

13. You will be taken back to the main page of that attachment category. You can add
another document under that category if needed. If you don’t need to add any
additional documents, then select Back.

14. Follow steps 7-13 to add a document under other categories.

Note: If you need to delete an attachment, click the attachment (one time) and select
Delete at the top of the page. It will ask you to confirm. Select Confirm. Once
you do that, the attachment will be deleted.

GoTo Top of the Document
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Viewing Other Agency Attachments (Basic Overview)
Login to CAREWare.

2. Select Find Client and search for the correct one.

3. Once the client file is open, select Annual Review from the menu of links on the left-hand

side.

4. Select Annual Custom.

From there, you have a few options. More than likely, the page will be blank, which
means you will need to add the year in order to add or view any attachments. If the year
is already there, then you can select View. However, if there is no year, select Add.

6. Select the current year. Then select Save.

10.

11.
12.

13.

Notice that it still says zero attachments. In order to see if another agency has already
added an attachment, either double-click the year or click once and select View.

If an attachment has been added, there will be a number next to the category. For
example, if it says 1 Attachments next to income documentation, that means that one
attachment has been uploaded.

To view the attachment in that category, click it. The attachment page will open and
show all of the attachments under that category.

Double-click the attachment to view it in detail. Then click the name of the file. It will
open in a separate tab.

Print or download the document for your records.

Exit the tab when you are done viewing the document. That will take you back to
CAREWare.

Select Back to return to the main page.

GoTo Top of the Document
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Uploading Attachments (Detailed Overview)
1. Select Find Client.

2. Once the client file is open, select Annual Review from the menu of links on the left-
hand side.

Delete Client  Back

GoTo Top of the Document
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3. Select Annual Custom.

4. If the page is blank, select Add.

Edit Back Help Printor Export

4A. If there is a year available, either double-click the year or click once and select View.

 Clier 1>

View Add Edit Back Help Printor Export

HIV Inm! Irlsu% lﬁsa:ﬂnsil

. :—'élﬂﬁ:—'ﬁﬁaﬁ:—'ﬁﬁaﬁ:—'ﬁﬂﬁﬁﬁﬁaﬁ

GoTo Top of the Document

Revised December 2022
Page 27



5. Select the current year. Then select Save.

Find Client > Search Resulis > Demographics > Annual Data > Annual Custom > Add

Save Cancel

Add

Year: 202—D| B _
HIV Status Documentation: 0 Attachments (Access in view mode only)
Income Documentation: 0 Attachments (Access in view mode only)
Insurance Documentation: 0 Attachments (Access in view mode only)
Miscellaneous Documentation: 0 Attachments (Access in view mode only)

Residency Documentation: 0 Attachments (Access in view mode only)

6. Double-click the year again. Everything will be grayed out. (It is supposed to look like

that, so don’t worry. ) Do not select edit. Instead, select the category that you want to
add an attachment.

Find Client > Search Results > Demographics > Annual Data » Annual Custom > Add > View

Edit Back

View
Year: 2020
HIV Status Documentation: 0 Attachments {Access in view mode only)
Income Documentation: 0 Attachments (Access in view mode only)
Insurance Documentation: 0 Atfachments (Access in view mode only)
Miscellaneous Documentation: 0 Atftachments (Access in view mode only)

Residency Documentation: 0D Attachments {Access in view mode only)

7. Select Add.

Find Client » Search Results > Demographics = Annual Data » Annual Custom > Add> View = 0 Attachments

View Add Edit Delete Link Back Print or Export

Attachments

Search: |

Content Type Attach Date Attach User Mod Date Mod User File Type File Name

GoTo Top of the Document
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8. Select Choose Files and choose the correct file. Again, make sure it is a PDF.
Find Client = Search Results > Demographics > Annual Data = Annual Custom > Add = View > 0 Attachments > Add

Mext Back

Add

File Name(s): | Choose Files | Mo file chosen

9. After selecting the file, make sure it says Upload Completed Successfully. Then select
Next.

Find Client = Search Results > Demographics > Annual Data > Annual Custom > Add > View > 0 Attachments > Add

Mext Back

Add

File Name(s): Choose Files | Income_HFHS pdf Upload Completed Successfully. (307.09 KB of 307.09 KB)

10. Under content type, select PDF from the drop-down menu. You can also add a comment.
When complete, Save.

Find Client = Search Results = Demographics = Annual Data > Annual Custom > Add = View = 0 Attachments = Add > Next

Save Back
Next
Income HFHS.pdf
Content Type: PDF

Comment: |Add comment if necessary |

This is what a fully submitted attachment looks like. If you need to add another
under the same category, follow steps 4 -10.

Find Client > Search Results > Demographics > Annual Data > Annual Custom> Add > View=> 0 Attachments

View Add Edit Delete Link Back Print or Export

Attachments

Search:

Content Type Attach Date Attach User Mod Date Mod User File Type File Name
PDF 412312020 Owensg4561 4232020 Owensg4561 pdf Income_HFHS

If you don’t need to add any additional documents, then select Back.
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11.

Find Client > Search Results > Demographics > Annual Data > Annual Custom > Add> View> 0 Attachments

If you need to delete an attachment, click the attachment and then select Delete.

Edit Delete Link Back Printor Export

View Add
Attachments

Search: |

Content Type Attach Date Attach User Mod Date Mod User File Type File Name )
' PDF 412312020 Owensg4561 42302020 Owensg4561 .pdf Income_HFHS

12. You will be asked to confirm. Select Confirm.

M ocecconm @

Please confirm before deleting the selected record

ot

Confirm Cancel

13. Once you confirm, the attachment will be deleted.
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Viewing Other Agency Attachments (Detailed Overview)

1. Select Annual Custom.

2. You will need to add the current year in order to see any attachments that have been
uploaded. Select Add.

Edit Back Help Printor Export

-

X &
53

3. Select the current year. Save.
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5.

Notice that it still says zero attachments. In order to see if another agency has already
added an attachment, either double-click the year or click once and select View.

Client Resolutioy » View More Information » Personal Info > Demographics > Annual Data > Annual Custom

View Add EdQt Back Help Printor Export

Search:

=
Year W Inco Insu Misc Resi
2020 0Aft OAl 0AR 0AR 0AR

Now, you will be able to see if an attachment has been added to any of the categories.
Click the attachment.

Client Resolufion > View More Information > Personal Info > Demographics > Annual Data > Annual Custom > View

Edit Back

View
Year: 2020
HIV Status Documentation: 1 Attachments (Access in view mode only)
Income Documentation: 0 Attachments (Access in view mode only)
Insurance Documentation: 0 Attachments (Access in view mode only)
Miscellaneous Documentation: 0 Attachments (Access in view mode only)

Residency Documentation: 0 Atfachments (Access in view mode only)

6. To view the attachment, either double-click or click once and select View.

Client Resolution > View More Information » Personal Info > Demographics > Annual Data » Annual Custom > View > 1 Attachments

View Add Edit Delete Link Back Print or Export

Attachments

Search:

Conten Attach D?ite Attach User Mod Date Mod User Fi File Name Comment
PDF 412312020 Owensg4561 412372020 Owensg4561 .p Income HFHS

GoTo Top of the Document

Revised December 2022 Page 32



7. Click the name of the file.

Client Resolution > View More Information » Personal Info > Demographics > Annual Data > Annual Custom > View > 1 Attachments > View
Edit Back

View
File Name: Income_ HFHS.pdf

Content Type: [PDF

Comment:

8. The file will open in a separate tab. Print or download the document for your records.

..].
MICHIGAN CAREWARE USER REQUEST
Michigan Department of Health and Human Services

Technical Support Email: MDHHS-DHSP-TAandData-Requests@michigan.gov Fax: 517-335-7209

ADD CAREWARE USER

Agency Date
Program

[[]Ryan White Part A [ ] Ryan White Part B [ ] Ryan White Part D [ ] Care Coordination
[] Data to Care [] Tobacco Cessation [ ] Other

Name (Last, First) Phone Email Address

Job Title MILogin ID

9. Exit the tab when you are done. That will take you back to CAREWare. Select Back to
return to the main page.

Client Resolution > View More Information > Personal Info > Demeographics > Annual Data > Annual Custom > View > 1 Attachments > View
Edit Back

View
File Name: Income_HFHS.pdf

Content Type: FPDF

Comment:

Note: Do not select Edit. This is only needed if you want to edit the document. The only

time you will need to use this function is if you need to edit a document you have
uploaded.
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What You Must Enter into CAREWare for the
Ryan White Services Report (RSR)

The Ryan White HIV/AIDS Programs Services Report (RSR) is a client-level data reporting
requirement that monitors the characteristics of Ryan White HIV/AIDS Program Parts
recipients, providers, and clients served. All Ryan White HIV/AIDS Program-funded
recipients (Parts A-D) and their contracted service providers are required to report client-
level data annually to the HIV/AIDS Bureau through the RSR.

In order to limit the amount of data clean up that has to be done at the end of the year, it is
imperative that you enter in all of the relevant information that is needed for the report.
Below is a list of items that must be entered in CAREWare for the RSR:

Located under the Demographics tab

1. Enrollment Status/Eligibility

2. Vital Status (Alive, Deceased)

3. Race/Ethnicity (includes Asian and Hispanic Subgroups)
4. Gender

5. HIV Status

6. HIV Risk Factor
Located under the Annual Review tab
7. Housing Status
8. Poverty Level
9. Medical Insurance
Located under the Medications tab
10. ART Medications
Located under the Services tab
11. Services Provided
Located under the Labs tab
12. CD4/Viral Load Tests
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CAREWare 6: Running Financial Reports

This guide will walk you through the basics of creating and running a financial report. It
includes definitions of all financial report fields.

What is a Financial Report?

Financial reports are used to calculate the total number of clients receiving
individual services. For example, you can run a financial report to see how many
clients received EIS services at your agency. However, financial reports will not tell
you any client names or other information. For that, you will need a custom report.

You can also customize your financial reports to pull in specific criteria. For
instance, you can filter a report that only calculates female clients who have
received services at your agency.

Financial Report Field Definitions
Begin Date & End Date: Date range you want to measure

- Funding Source Filter: Use this to pick the correct contract. Examples include
MAI (Part A), Part A, Part B, etc.

- Edit Filter: This is used to add a filter to the financial report. For example, use edit
filter to calculate the number of female clients who have received services at your
agency

Run: Use this to run the report
« PDF: Runs the report as a PDF
Back: Use this to go back to the previous page or step

+ Include Subservice Detail: Includes all services plus their subservices. Examples
include EIS Discharge, MCM Discharge, OAHS Medical Complex, etc.

- Filter Description: Describes the filter created (if applicable)
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Running a Basic Financial Report (Quick Overview)
Login to CAREWare.
Select Reports tab.
Select Financial Report from the menu of links.
Specify the Begin Date & End Date.

Select Funding Source Filter. Choose the correct funding source. If it is multiple
funding sources, make sure you check all that apply. If your funding source is not on
the first page, you can type it into the search box.

ok 0bd =

6. Select Save. This will take you back to the main page of the financial report. From
there, you can run your report.

7. Select Run. On the upper right-hand side, you will see a box that lets you know the
report is running.

8. Once the report has generated, you will receive a message that says Complete (on
the upper right-hand side too). Click View Financial Report.

Note: If you want to save the file or view it as a PDF, you should run it as a PDF.
Click PDF instead of Run.

Adding a Filter to the Financial Report

1. Follow steps 1-6. Then select Edit Filter.
2. Select Add.

3. Select the criteria you would like to use for the filter from the list provided by clicking
on the field name and clicking Use Field. You can narrow down the list by typing in
the search bar at the top.

4. Most field selections will have you set parameters by using the Drop-down List.
Enter the necessary information under the drop-down menu.

5. Select Save.

6. You can add as many filters as you need. Once you are done adding filters, click
Back. This will take you back to the financial report main page.

7. Click Apply Filter.
8. Then select Run Report or PDF.

9. Once the report has generated, you will receive a message that says Complete (on
the upper right-hand side too). Click View Financial Report.

GoTo Top of the Document

Revised December 2022 Page 36



Running a Basic Financial Report (Detailed Overview)
Select the Reports tab.
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3.

4.

This will take you to the main page for financial reports.

Specify the Begin Date & End Date.

Funding Source Filter  Edit Fiter Run PDF Help Back

0170112019
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5.

Choose Funding Source.

@ " CAREWare Reports = Fi ial Report i =F il Filter
Customize

Add Client Save Cancel Print or Export

Find Client - -

Do Funding Source Filter

Rapid Entry Search’ |Part
Appointments

My Settings Select Funding Source
System Information Cares Part D
System Messages
=i X A EIS Supplemental Part B

Administrative Options
Switch Providers MAI (PART A
Log Off 7 Part A

PartB
For system issues please contact PartC
us at MDHHS-
CAREWareSuppori@michigan.gov Part D

Note: You can type the funding source into the search bar to narrow down the list. You

can also check multiple funding sources.

Save.
@ " CAREWare Reports > Financial Report Settings = Funding Source Filter
Customize
Add Client Save Cancel Print or Export
Find Client = =
Repiorts Funding Source Filter
Fapud Entey Search: |Part
Appointments
My Settings Select Funding Source
System Information Cares Part D
System Messages e iR
upplemental Pa
Administrative Opfions r
Switch Providers wl MAI (PART A}
Lag Of 7 Part A
Fart B
For system issues please contact PartC
us at MDHHS-
CAREWareSupport@michigan.gov PartD

This will take you back to the main page of the financial report. From there, run your
report. You have two options: Run the report or run it as a PDF.

@ i CAREWare Reports > Financial Report Settings

Customize

Add Client Funding Source Filter EditFilter Run PDF Help Back

Find Client ) . .

Reports Financial Report Settings

Rapid Entry :

Appointments Begin Date: |1/1/2018

My Settings End Date: 7/3012019 3

System Information
System Messages
Administrative Options
Switch Providers

Log Off

Funding Sources; MAIL (PART A), Part A

oo s

GoTo Top of the Document
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Running. You want to see this box.
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9.  Once the report generates, you will receive a message (also on the upper right-
hand side) that says Complete. Click View Financial Report.

. Complete

View Financial Report

10.Your report should look like this.

Financial Report
Tuesday, January 1, 2019 through Tuesday, July 30, 2019
Report Criteria:

Providers: Henry Ford Hospital

Funding Sources: Part A MAI (PART A)

Group By Providers: False

Include Subservice Detail: False

Receipts In Period: False

Henry Ford Hospital

Early Intervention Services Clients: Units: Total: Amount Received: Not Received:
Early Intervention ServicesTotals: 9% ik $0.00 $0.00 §0.00
Outpatient’/Ambulatory Health Services Clients: Units: Total: Amount Received: Not Received:
Outpatient/Ambulatory Health ServicesTotals: 619 1827 50.00 $0.00 §0.00
Provider Totals: 644 2954 50.00 $0.00 $0.00

Note: The report will open up on a separate tab. When you need to exit the report, simply
close the tab. That will take you back to CAREWare.

GoTo Top of the Document

Adding a Filter to the Financial Report

1. Follow steps 1-6 of running a basic financial report. Then select Edit Filter.
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@ Customize
Add Client

Find Client
Reports

Rapid Entry
Appointments

My Settings
System [nformation
System Messages
Administrative Options
Switch Providers
Log Off

For system issues please contact
us at MDHHS-
CAREWareSupport@michigan.gov

2. Select Add.

@ Customize
Add Client

Find Client
Reports

Rapid Eniry
Appointments

My Settings
System Information

CAREWare Reports > Financial Report Settings
Funding Source Filter EditFiter Run PDF Help Back

Financial Report Settings
Begin Date: _1.’74‘2019
End Date: |7/30/2019

Funding Sources: MAL (PART A), Part A

Include Subservice Detail?:

Include Provider Information?:

Pull Amount Received from receipts in the date span?:
Apply Filter:

Filter Description: |Report Filter is empty

CAREWare Reports > Financial Report Settings = Edit Filter

Manage Add MoveUp Move Down

Report Filter

Search:

Operator Paren.

Delete  Templates Back

Field Name Is Not

Print or Export

3. Select the criteria you would like to filter from the list provided and click Use Field. You

can narrow down the list by typing the name in the search bar at the top.

@ Customize
Add Client

Find Client
Reports

Rapid Entry
Appointments

My Settings
System Information
System Messages
Administrative Options
Switch Providers
Log Off

CAREWare Reports > Financial Report Settings = Edit Filter » Add
Use Field Back Print or Export

Report Fields

Search: HIV Risk factor

Field Name Keywords

Hemephiliac HIV risk factor Demegraphics
Heterosexual HIV risk factor Demographics
HIV Risk Factor Demographics
Perinatal HIV transmission risk Demographics

Revised December 2022

Previous Field Nar Description

Hemo Returns yes or no

Hetero Refurns yes or no

HIV Risk Factor

Peri Returns yes or no if
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4. Most filters will require you to set parameters (provide more information because the field
has a wide range of options). Click the drop-down menu to set those parameters.

@ Customize
Add Client

Find Client

Reports

Rapid Entry
Appointments

My Settings
System Information
System Messages
Administrative Options
Switch Providers
Log Off

5. Save

@ Customize
Add Client

Find Client
Reports

Rapid Entry
Appointments

My Settings
System Information
System Messages
Administrative Options
Switch Providers
Log Off

CAREWare Reports > Financial Report Settings > Edit Filter > Add > Criterion Details
Save Back

Use Field

Field Name: |HIV Risk Factor

[Heterosexual

Is Not:

Null:

CAREWare Reports > Financial Report Settings > Edit Filter > Add > Criterion Details
Save Back

Use Field

Field Name: HIV Risk Factor
Is Not:
= |Heterosexuall '

Null:

6. Add as many filters as necessary. For instance, you could add a filter for race, age, virally
suppressed clients, etc. If you need to add multiple filters, make sure you choose the
correct operator. There are two choices for operator:

Operator = AND means all of criteria has to be met in order to pull in clients.

Operator = OR means that any of the filters can be met in order to be pulled into

@ Customize
Add Client

Find Client

Reports

Rapid Entry
Appointments

My Settings
System Information
System Messages
Administrative Options
Switch Providers
Log Off

Revised December 2022

the report.
CAREWare Reports > Financial Report Settings > Edit Filter > Add > Criterion Details
Save Back
Use Field
Operator: |AND
Paren.:

Field Name: |Race/Ethnicity
Is Not:
=
Null:

Paren.:
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7. Once you are done adding all of your filters, click Back. This will take you back to the
financial report main page.

@ . CAREWare Reports > Financial Report Settings > Edit Filter

Customize

Add Client Manage Add MoveUp Move Down Delete Templates Back  Print or Export

Find Client .

Reports Report Filter

Rapid Entry S

Appointments

My Settings Operator Paren. Field Name Is Not = ==
System Information HIV Risk Factor Heterosexual

System Messages

like.

9. Select Apply Filter. It is important that you select Apply Filter in order for the filter to be pulled

into the ort. Then, click Run of PDF.
@ Cuslomis AREWare Reports > Financial Report Settings
Add Client 1ding Source Filter  Edit Filter elp Back
Find Client \ ) "
Reports ncial Report Settings
Rapid Entry e
AT Begin Date: |1/1/2019 7
My Settings End Date: |7/30/2018 ﬁ

System Information
System Messages
Administrative Options
Switch Providers

Log Off

Funding Sources: [MAT (PART A}, Part A

For system issues please contact
us at MDHHS-
CAREWareSupport@michigan.gov Include Prider Information?:

Subservice Detail?:
Pull Amount Received from receipts iq@ie date span?:
Apply Filter: |+

Filter Description; |HIV Risk Factor = Heterosexual

Note: Once Apply Filter is checked, it will stay checked until you uncheck it. That

once you are done running your report.

means that anyone from your agency who tries to run a report will have that filter
applied to it. That will skew your data, so please make sure you uncheck the box

GoTo Top of the Document
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10.0Once the report is generated, this is what it will look like. View or save it.

Financial Report
Tuesday, January 1, 2019 through Tuesday, July 30, 2019
Report Criteria:
Providers: Henry Ford Hospital
Funding Sources: Part A, MAI (PART A)
Group By Providers: Falze
Include Subservice Detail: False
Receipts In Period: False
Custom Filter: HIV Risk Factor = Helerosexual

Henry Ford Hospital

Early Intervention Services

Clients:

Units: Total: Amount Received: Not Received:
Early Intervention ServicesTotals: 2% 266 §0.00 $0.00 §0.00
Quipatient/Ambulatory Health Services Clients: Units: Total: Amount Received: Not Received:
OutpatientiAmbulatory Health ServiceaTotals: pri) 654 §0.00 50.00 §0.00
Provider Totals: ATl 920 $0.00 $0.00 §0.00

Note: This is how you know the filter has been applied to the report.
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CAREWare 6: Running a Performance Measure

What is a Performance Measure?

Performance measures generate reliable data on the quality-of-care clients receive;
this can be measured at an agency level or by funding sources such as Part A or
Part B. Performance measures are used to calculate many things including:

The number of virally suppressed clients

The number of clients prescribed ARTs

The number of clients that had medical visits during the year
There are two ways to run performance measures:

Run a Basic Performance Measure

Run a Performance Measure Client List

The Basic measure pulls the percentage of clients that meet the criteria of the
performance measure.

The Client List report pulls the actual clients that meet or do not meet the criteria for
the performance measure.

Running a Basic Performance Measure

Quick Overview:

1.

A Sl

© ® N

10.

11.

12.

Login to CAREWare.

Select the Reports tab.

Select the Performance Measures tab.
Select Run Performance Measures.

A list of all performance measures will appear. Select the performance measure you
want to run. You can use the search box to narrow down your search.

Select Evaluate Selected at the top of the page.
This will take you to the page to set the parameters of your report.
Click Edit.

Specify the As of Date (this will be the date at which the performance measure stops).
For example, an as of date of 09/30/19 would indicate to CAREWare to run data for
one year back from that date (09/30/18 — 09/30/19). Once you add the date, Save it.

Select Run. On the right-hand side, you will see a box that lets you know the report is
running.

Once the report has generated, you will receive a message that says Report
Generation Complete (on the right-hand side too). Select View Report.

If you want to run multiple reports at once, click all the ones you want to run
(step 5). Then follow the subsequent steps.

Note: The report will open on a separate tab. In order to get back to CAREWare, simply

exit the tab. That will take you back to the performance measure tab.

GoTo Top of the Document
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Running a Performance Measure Client List

Quick Overview:
Login to CAREWare.
Select the Reports tab.

Select the Performance Measures tab.
Select Create Client List.

ok~ wbd =

A list of all performance measures will appear. Select the performance measure you
want to run. You can use the search box to narrow down your search.

Select Use Selected at the top of the page.

This will take you to the page to set the parameters of your report. This is where you
choose the date, section, and output format.

Click Edit.

Specify the As of Date, Performance Measure Section (there are four options: Not
In Numerator, In Numerator, In Denominator, and Not in Denominator) and Output
Format (this is how you will see the report as a separate document or in
CAREWare).

10.  Once you make your selections, click Save.
11.  Select Create Client List.

Note: If you run the report as a separate document, you will receive a message on the
right-hand side that says the report is generating and lets you know once you can
view it.

GoTo Top of the Document
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Detailed Overview: Running Basic Performance Measure
1. Select the Reports tab.

9 Customize
Add Client

Find Client
Reports

Rapid Entry
Appointments

My Settings
System Information
System Messages
Administrative Options
Switch Providers
Log Off

2. Select Performance Measures.

e . CAREWare Reports
Customize

Add Client

Find Client @®CAREWare Reports

Reports

Rapid Entry

g HRSA Reports RSR and ADR

Appointments

My Settings

System Information Custom Reports Run or manage custom reports

Systerm Messages

G T GRS TS Periormance Measures Run or Manage Performance Measures

Switch Providers

Log Off

Client Data Reports Run reports on client information

This is a test notification Financial Report Setup and run the financial report
Don't forget to contact the Administrative Reports Administrative reports and options

helpdesk if you would like o
schedule an appointment to
receive assistance upgrading to Permission Reports Run and search permissons held by a user at a point in time
CAREWare 6.

3. Select Run Performance Measures.

® . CAREWare Reporis > Performance Measures
Customize

Add Client Back

Find Client

ot @®Performance Measures

Rapid Entry

Appointments

My Settings Run Ferformance Measures Evaluate the current status of one or more performance measures
System Information

System Messages

Create Client List Examine clients in the performance measure sections
Administrative Options
Switch Providers
Log Off Create Aggregate Report Track results for a performance measure over time
Set up, Copy, and Customize Performance Measures Manage the list of available performance measures
This is a test notifi
Import Performance Measures Import external performance measures from file
Don't forget to contact the
helpdesk if you would like fo - .
schedule an appointment fo Export Performance Measures Create an export containing perfo I ons
receive assistance upgrading to
CAREWare 6.
Setup Client Tab Configure the performance measure tab within the client record
HIVQM Export Groups Manage HIVQM Export Groups
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4. Alist of all performance measures will appear. Select the performance measure you
want to run. You can use the search box to narrow down your search.

@ 2 CAREWare Reports > Performance Measures > Ewvaluate Measures
Customize

Ewvaluate Selected Ewvaluate Group Back Print or Export

Find Client
gt Evaluate Measures
; Search: |CORE01AI
My Settings =
System Information Selected Code Name Description
System Messages COREOAH Viral Load Suppres: Percentage of clieni

Administrative Options
Switch Providers -
Log Off el CORED1A HAB: Viral Load Su| Percentage of clien

CORED1AM HAE: Viral Load Su| Percentage of clien

For system issues please contact
us at MDHHS-
CAREWareSupporti@michigan.gov

5. Select Evaluate Selected (top of page).

@ : CAREWare Reports > Performance Measures > Evaluate Measures
Customize
Evaluate Selected Ewaluate Group Back Print or Export
Find Client
Repork Evaluate Measures
Search: 'C_DREG‘!AI
My Settings — =
System Information Selected Code Name Description
System Messages CORED1AH \firal Load Suppres: Percentage of clien
Administrative Options ) )
, = COREO1AM HAE: Viral Load Su| Percentage of clieni
Switch Providers
Log Off 7 COREO1A HAE: Viral Load Su| Percentage of clienl

For system issues please contact
us at MDHHS-
CAREWareSupport@michigan.gov

6. This will take you to the page to set parameters for your report. Click Edit.

@ Cisboraia CAREWare Reports > Performance Measures > Evaluate Measures > Performance Measure Settings
Edit Selected Providers Today Run Back

Find Client .

Reports Performance Measure Settings

Parameters

My Settings
System Information AsOfDate: |12/31/2018
System Messages
Administrative Options
Switch Providers

Log Off

Performance Measures: |HAB: Viral Load Suppression_Part A. (CORE@1A)

For system issues please contact

us at MDHHS- et e A 7 s 3

CAREWareSupport@michigan.gov Selected Providers: |Henry Ford Hospital, Matrix Human Services, Oakland Integrated Health
N

etwork

7. Select the As of Date (this will be the date at which the performance measure stops).
For example, an as of date of 09/30/19 would indicate to CAREWare to run data for
one year back from that date (09/30/18- 09/30/19).
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8. Save.

@ Customize
Add Client

Find Client
Reports

Rapid Entry
Appointments

My Settings
System Information
System Messages
Administrative Options
Switch Providers
Log Off

This is a test notification

9. Select Run.

@ Customize
Add Client

Find Client

Reports

Rapid Entry
Appointments

My Settings
System Information
Systam Messages
Administrative Options
Switch Providers
Log Off

This is a test notification

CAREWare Reports > Performance Measures > Evaluate Measures > Performance Measure Settings > Edit

Save Cancel

Performance Measure Settings

Parameters

AsOfDate: [9/3012019

Performance Measures: |HAB: HIV viral load suppression (Core@l)

CAREWare Reports > Performance Measures > Evaluate

Edit Today Run Back

Measures > Performance Measure Settings

Performance Measure Settings

Parameters

AsOfDate: (9/30/2019

Performance Measures: |HAB: HIV viral load suppression (Cored8l)

generating.

Note: On the right-hand side, you will see a box that lets you know the report is
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10.  Once the report has generated, you will receive a message that says Report

Generation Complete (on the right-hand side too). Select View Report.

®}

. Report generation complete.

View Report

The report will open on a separate tab. This is what it looks like:

Multiple Performance Measures Report 9/30/2019

Selection: State ADAP Program

Code: Name: Numerator: Denominator: Percent:

Corell HAB: HIV viral load suppression 0 2 0.00%

In order to get back to CAREWare, simply exit the tab. That will take you back to the
performance measure tab.
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Detailed Overview: Running a Performance Measure Client List

1. Follow steps 1-3 of running a basic performance measure.
2. Select Create Client List.

@ Customize
Add Client

Find Client

Reports

Rapid Entry
Appointments

My Settings
System Information
System Messages
Administrative Options
Switch Providers
Log Off

This is a test notification

Don't forget to contact the
helpdesk if you would like fo
schedule an appointment to
receive assistance upgrading to
CAREWare 6.

CAREWare Reports > Performance Measures

Back

®Performance Measures

Run Performance Measures

Create Client List

Create Aggregate Report

Set up, Copy, and Customize Performance Measures

Import Performance Measures

Export Periormance Measures

Setup Client Tab

HIVGM Export Groups

Evaluate the current status of one or more performance measures

Examine clients in the performance measure sections

Track results for a performance measure over time

Manage the list of available performance measures

Import external performance measures from file

Create an export containing performance measure configurations

Configure the performance measure tab within the client record

Manage HIVQM Export Groups

3. Alist of all performance measures will appear. Select the performance measure you want

to run.

4. Select Use Selected.

@ Customize

Add Client
Find Client
Reports
Rapid Entry
Appointments

CAREWare Reports > Performance Measures > Client List

Use Selected Back

Client List

Search: |core

Print or Export

My Settings

System Information
System Messages
Administrative Options
Switch Providers

Log Off

This is a test notification

Revised December 2022

Code Name Description

Core2 HAE: Prescription of antiretroviral thel Percentage of clienl
Corel1 HAE: HIV viral load suppression Percentage of client
Core04 HAE: Gap in HIV medical visits Fercentage of client
Core03 HAE: HIV medical visit frequency Percentage of client
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5. This will take you to the page to set parameters for your report. Select Edit.

@ Ciidioi CAREWare Reports > Performance Measures > Client List > Performance Measure Client List Settings
ustomize

Add Client Edit Today Create ClientList Back

Find Client

Reports Performance Measure Client List Settings

Rapid Entry

Appointments Performance Measure: |HAB: HIV viral load suppression

My Settings As Of Date: |9/30/2019

System Information .
Performance Measure Section: |In Numerator
System Messages

Administrative Options Qutput Format: |Quick Paper List
Switch Providers

Log Off

6. Specify the As of Date, Performance Measure Section, and Output Format.
7. Select Save.

@ Ciistorine CAREWare Reports > Performance Measures > Client List » Performance Measure Client List Settings
Add Client ﬂmE'

Find Client

Reports Performance Measure Client List Settings
Rapid Entry

Appointments Performance Measure: |HAB: HIV viral load suppression

My Seftings As Of Date: |9/30/2019 b

System Information Performance Measure Section: |In Numerator

System Messages

Administrative Options Output Format: |Quick Paper List

Switch Providers

Log Off

Note: For Performance Measure Section, there are four options: Not in Numerator pulls
clients who don’t meet the criteria of the measure; In Numerator pulls clients that
meet the criteria for the measure; Not in Denominator pulls clients who are not
even considered for the measure; In Denominator pulls all clients who are
considered for the measure.

For example, you are running a report to pull the number of clients who are virally
suppressed:

-In Numerator would pull all clients who are virally suppressed
-Not in Numerator would pull all clients in the denominator but are not virally suppressed

-Not in Denominator pulls clients who are not even considered for the measure- ex.
Those who did not have an appointment within the measurement year

-In Denominator pulls all clients who could potentially be virally suppressed
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For Output Function, you have two options:

1. Real-time Lookup List allows you to click on client in the list and go to their CAREWare
file. There is no need to exit the performance measure tab.

2. Quick Paper List generates a report that can be viewed, saved, or printed.
8. Select Create Client List.

@ Cust : CAREWare Reports > Performance Measures > Client List > Performance Measure Client List Settings
ustomize

Add Client Edit Today Create ClientList Back

Find Client

Reports Performance Measure Client List Settings

Rapid Entry

Appointments Performance Measure: |[HAE: HIV viral load suppression

My Settings As Of Date: [9/30/2019

System Information ; =

Svstem Messages Performance Measure Section: |In Numerator

Aaministralive bptions Qutput Format: |Quick Paper List

External Links
Switch Providers
Log Off

9. Once the report generates, you will receive a message that says Report generation
complete (on the right-hand side). Click View Report. The report will open in a separate
tab.

This only happens if you select Quick Paper List as the report output.

®)

. Report generation complete.

View Report

10.1f you select Real-time Lookup list as the output, then this is what the report will look
like. Select the client you would like to view, then click Go to Client. This will take you to
the client record in CAREWare.

@, s CAREWare Reports > Performance Measures > Client List > Performance Measure Client List Settings =
Add Client Go To Client Back  Print or Export

Find Client - - - = .

R HAB: Prescription of antiretroviral therapy

Rapid Entry Search:

Appointments

My Settings Client Viewed

System Information Fields, Sally

System Messages
Administrative Options
External Links

Cueen, Cliver

Samuels, Tammie
Switch Providers SHmue, Tanuire
Log Off Samuels, Tammie

Smith, John
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CAREWare 6: Building a Custom Report

This guide will walk you through the basics of building a custom report
utilizing a filter that looks at clients by:

U Encrypted URN

0 Race

0 Last Quantitative Lab Date (Viral Load)
0 Last Quantitative Lab Value (Viral Load)

Detailed Overview:
1.  Select Reports.

@ Customize
Add Client

Find Client
Reports

Rapid Entry
Appointments

My Settings
System Information
System Messages
Administrative Options
Switch Providers
Log Off

For system issues please contact
us at MDHHS-
CAREWareSupport@michigan.gov

2.  Select the Custom Reports tab.

@ N CAREWare Reporis

Customize

Add Client

Find Client ®CAREWare Reports

Reports

Rapid Entry

: HRSA Reports RSR and ADR

Appointments

My Settings

System Information Custom Reports Run or manage custom reports
System Messages

Ad!l'nmlstratlffe Spiize Performance Measures Run or Manage Performance Measures
Switch Providers

Log Off

Client Data Reporis Run reports on client information
For system issues please contact Financial Report Setup and run the financial report
us at MDHHS-
CAREWareSuppert@michigan.gov
Administrative Reports Administrative reports and options
Permission Reports Run and search permissons held by a user at a point in time
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3. Select Manage/Run Custom Reports.

@ Customize
Add Client

Find Client

Reports

Rapid Entry
Appointments

My Settings
System Information
Systemn Messages
Administrative Opfions
Switch Providers
Log Off

For system issues please contact
us at MDHHS-

CAREWare Reporis > Custom Reporis

Back

®Custom Reports

Manage/Run Custom Repaoris

Export Custom Reporis

Import Custom Reports from an xmi file

CAREWareSupport@michigan.gov

Run or manage custom reports

Export custom report definitions to a portable xml file

Import custom report definitions from a portable xmil file

4.  This will take you to the main page for custom reports. This is where you will run all
custom reports in your domain. To create a new report, select Add.

@ Customize
Add Client

Find Client
Reports

Rapid Entry
Appointments

My Settings
System Information
System Messages
Administrative Options
Switch Providers
Log Off

For system iszues please contact
us at MDHHS-
CAREWareSupport@michigan.gov

CAREWare Reports » Custom Reports > Manage Run Custom Reports

Manage Run

Add Delete

Make Read Only

Back Help Print or Export

Manage/Run Custom Reports

Search:

Name

CM full client list
Beaumant

race and name JS
IMH CM dual enrolin
PERF.IND:MCMAdF
PERF.IND:MCMAd!
Mental Health
RDR#24 new client:

CrossTab

Report Type Description Read Only
Service

Service

Demographics

Service

Service

Service

Service

Demographics

Date Created

121312015 12:07 Pl
121312015 12:05 PN
511712016 11:08 AN
121312015 12:08 PN
12132015 12:04 PN
121312015 12:04 Pl
10/18/2016 9:42 AN
121312015 12:09 Pl

5. A box will pop up. Type in a Report Name, select a Report Type, and indicate if the
report is a crosstab. For most reports, the report type will be Demographic or
Service. Then select Save.
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@ CAREWare Reports > Custom Reports > Manage Run Custom Reports > Add
Customize

Add Client Save Back

Find Client

Reports Add

Rapid Entry

Appointments Setup Details

My Settings Report Name: Building a Custom Report

2"2:;: L:';‘::;Z‘;" Report Type: Demographics =
Administrative Options Is Crosstab:

Switch Providers e e

Log Off

For system issues please contact
us at MDHHS-
CAREWareSuppori@michigan.gov

New Feature:

YOU can Use Totals: et mor
change the  INEEG—_— -
font size and e

font color of naenine: |

your report. - Em

Note: A crosstab is a table that shows the number of times each of the possible
category combinations occurred in your data. For example, you could select a
crosstab for gender and zip code. When you run the report, it would show you the
number of male, female, and transgender clients in each zip code.

6. This will take you to the page where you can edit and run the report. Select the Report
Filter tab. The report filter is utilized to filter out the specific information you want to
know. For example, if you only want to know information about medical visits, then you
would add the OAHS service category to the report filter. Other examples include:

- Selecting the funding source, you want to view (A,B,C,D)
- Selecting a specific time period
- Selecting clients based on gender, race, risk, age, etc.

@ Customi CAREWare Reports » Custom Reports > Manage Run Custom Reports > Building Custom Report Guide Test
ustomize
Add Client Back
Find Client
Reports ®Building Custom Report Guide Test
Rapid Entry
ROp Gl Start Date : 01/01/2018, End Date : 12/31/2018, Cl th Report Displ
) - tart Date ; 01/01/ , End Date . ! , Clients with services, Report Display as :
My Settings pti=ne Open in New Window
System Information
S\,fstenj Messages Report Layout Building Custom Report Guide Test, Demographics
Administrative Options
Switch Providers . o o o
: : eURN, HIV Risk Factor, Had Vaccination, Last Quantitative Lab Date, Last Quantitative Lab
Log OFf Field Selection i
Report Filter Report Filter is empty

For system issues please contact
us at MDHHS-
CAREWareSuppert@michigan.gov
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7. To add a filter, select Add.

@ Customize
Add Client

Find Client
Reports

Rapid Entry
Appointments

My Settings
System Information
System Message

Administrative Options
Switch Providers

Log Off

For system issues please contact
us at MDHHS-

CAREWareSupport@michigan.gov

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Building Custom Report Guide Test > Report Filter

Manage Add

Report Filter

Search:

Move Up  Move Down Delete Templates Back Print or Export

Operator Paren. Field Name Is Not = == <=

8. A very large list of filter options appears. For the purposes of this exercise, we will be
selecting all Part A clients that received a service in a year-long date span
(“Subservice Count by Funding in Date Span”). Type the name of the filter into the
search bar and double click the field name or select Use Field.

@ Customize
Add Client

Find Client
Reports

Rapid Entry
Appointments

My Settings
System Information
System Messages
Administrative Options
Switch Providers
Log Off

CAREWare Reports ® Custom Reports » Manage Run Custom Reports » Building Custom Report Guide Test > Report Filter > Add
Use Field Back

Report Fields

Search: \subservice cou

Print or Export

Field Name Keywords Previous Field Nar Description

Subservice count by funding in date span  Demographics Shs Count by Fundi Returns number of ¢

Subservice visit count X days apart Demographics Shbs Interval Count  Returns number of 1

Subservice Ceunt Demographics Subservice Count  Returns number of 1

Subservice Count by Funding Demographics Subservice Count b Returns number of !

Subservice Count In Span Demographics Subservice Count Ir Returns number of ¢

9.  This is where you will indicate the parameters of the filter. The parameter will differ
slightly among the filters. For Subservice Count by Funding in Date Span, three
fields have to be defined: funding source, date span, and cross-provider.

@ Customize
Add Client

Find Client

Reports

Rapid Entry
Appointments

My Settings
System Information
System Messages
Administrative Options
Switch Providers
Log Off

For system issues please contact

us at MDHHS-

CAREWareSupport@michigan.gov

Revised December 2022

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Building Custom Report Guide Test >
MNext Back Help

Subservice count by funding in date span>Subfilter

The following 3 criteria need completion for the subfilter
1. Funding Source

= |Parta e

2. Date Span (optional)

Date Option: |Months

e '12 Min. months before end date
e _D Max. months before end date
3. Cross-Provider

= |No 5

GoTo Top of the Document

Page 57



10. From the dropdown menu, choose the correct Funding Source, Date Span, and
Cross-Provider. Then select Next.

Note: Date Span can be in days, months, or specific dates. The default is now months.
Indicate the number of months/days you want to confine the report. The
maximum number of months goes in the first box (>=) and the minimum number of
months goes into the second box (<=). For example, if you want to look at a year,
the maximum months would be 12 and the minimum months would be 0. It would
look like the picture above.

Cross-Provider allows you to pull values from other provider domains (such as lab
values). When using lab fields, you should always select “yes” for cross-provider.
This will pull labs from any agency.

11.  This is where you indicate the number of services a client needs to receive in order to
be included in this report. For the purposes of most reports, a client needs to receive at
least one service. If that is the case, then indicate “1” in the >= box.

<= refers to clients that have less than or equal to a certain amount of services
= refers to clients that equal the number of required services

Is Not refers to clients who did not meet the field specifications (in this case, it
would be clients who didn’t receive a Part A service)

12. Save.
@ i CAREWare Reports » Custom Reports > Manage Run Custom Reports = Building Custom Report Guide Test =
ustomize
Add Client Save Back
Find Client = :
Reports Criterion Setup
Rapid Entry

= - o unt b inding In So
Appointments Field Mame: |Sbs Count by Funding In Span

My Settings Is Not:
System Information

System Messages

Administrative Options = |1
Switch Providers it
Log Off

For system issues please contact
us at MDHHS-
CAREWareSupport@michigan.gov
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13.

This will take you back to the report filter page. Add as many filters as needed. Once

you are done adding your filters, select Back.

@ Customize
Add Client

Find Client
Reports

Rapid Entry
Appointmenis

My Settings
System Information
System Messages
Administrative Options
Switch Providers
Log Off

For system issues please contact
us at MDHHS-
CAREWareSupport@michigan gov

14.

CAREWare Reports > Custom Reporis > Manage Run Custom Reports = Building Custom Report Guide Test > Report Filter

Manage Add Move Up Move Down Delete Templates Back Print or Export

Report Filter

Search:

Operator Paren. Field Name Is Not = == o=
Shs Count by Fundi 1

Select the Field Selection tab. The field selection lets you specify what you want to see

about the filtered clients. That includes name, eURN, race, age, address, last labs, last

services, etc.

@ Customize
Add Client

Find Client
Reports

Rapid Entry
Appointments

My Settings
System Information
System Messages
Administrative Options
Switch Providers
Log Off

For system issues please contact

us at MDHHS-

CAREWare Reports > Custom Reporis > Manage Run Custom Reporis » Building Custom Report Guide Test
Back

@Building Custom Report Guide Test

Start Date : 01/01/2018, End Date : 12/31/2018, Clients with services, Report Display as :

Run Report Open in New Window

Report Layout Building Custom Report Guide Test, Demographics

eURN, HIV Risk Factor, Had Vaccination, Last Quantitative Lab Date, Last Quantitative Lab

Field Selection Value
Subservice count by funding in date span ( Funding Source = Part A Date Span (optional)
Report Filter Between 12 AND 0 months before the end date or as of date (12/31/2017 And 12/31/2018).

AND Cross-Provider = No ) == 1

CAREWareSupport@michigan.gov

15. Select Add.

@ Customize
Add Client

Find Client

Reports

Rapid Entry
Appointments

My Settings
System Information
System Messages
Administrative Options
Switch Providers
Log Off

For system issues please contact
us at MDHHS-
CAREWareSupport@michigan.gov

Revised December 2022

CAREWare Reports = Custom Reports > Manage Run Custom Reports > Building Custom Report Guide Test >

Manage Add MoveUp MoveDown Delete Templates Back Print or Export

Field Selection

Search:

Field Name Column Header Column Width (in) Totals Sort S0
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16. For this report, we want to know four things: eURN, race, last viral load date & value.
Let’s start with eURN. To search for the field, type the name in the search bar. Select
the field and click Use Field.

@ Customi CAREWare Reports > Custom Reports > Manage Run Custom Reports = Building Custom Report Guide Test:
ustomize

Add Client Use Field Back Print or Export

Find Client =

Reports Report Fields

Rapid Entry Search: EURN

Appointments

My Settings Field Name Keywords Previous Field Nar Description

System Information Encrypted URN Demeographics eURN

System Messages
Administrative Options
Switch Providers

Log Off

For system issues please contact
us at MDHHS-
CAREWareSupport@michigan.gov

17. From here, you can customize the field. This includes changing the font and colors,
sorting, and setting priorities. For example, if you wanted to sort names in alphabetical

order, you could do that using the sort function. You could also prioritize name where it
shows up as the first column in your report.

@ Custombze CAREWare Reports > Custom Reports » Manage Run Custom Reporis > Building Custom Report Guide Test > Field Selection > Add > Use Field
Add Client Save Back

Find Client

Reports USE Fleld

Rapid Entry

Appointments Select Field: eURN

My Settings Column Header:  gURN

System Information
System Messages
Administrative Options
Switch Providers
Log Off Sort:
Sort Priority: |0
Header Column Format

For system issues please contact
us at MDHHS- Column Width: 1.2 inches

CAREWareSupport@michigan gov
Column Header Font Name: Arial
Bold:
Italic:
Underline:
Font Size: 8
Font Color: Black
Data Column Format
Font Name: Arial
Bold:
Italic:
Underline:
Font Size: &

Font Color: Black

(<l

Field Justification: Left
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18.

19.

20.

Save.

@ Customize
Add Client

Find Client

Reports

Rapid Entry
Appointments

My Seitings
System Information
System Messages
Administrative Options
Switch Providers
Log Off

For system issues please contact
us at MDHHS-
CAREWareSuppori@michigan.gov

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Building Custom Report Guide Test > Field Selection > Add > Use Field

Save Back

Use Field

Select Field:

Column Header:

Sort:

Sort Priority:

Column Width:

Column Header Font Name:
Bold:

Italic:

Underline:

Font Size:

Font Color:

Font Name:
Bold:

Italic:
Underline:
Font Size:
Font Color:

Field Justification:

0

Header Column Format

12 inches
Avial

a

Black

Data Column Format

Arial

Black

Left

You can view your selected field (to check for accuracy). If you don’t want to view the

field, select Back. This will take you back to the field selection page.

Repeat Step 15-19 (Select Add. From the list, select Race. Click Save. Click Back).

@ Customize
Add Client

Find Client

Reports

Rapid Entry
Appointments

My Settings
System Information
System Messages
Administrative Options
Switch Providers
Log Off

Faor sysiem issues please contact

us at MDHHS-

CAREWareSuppori@michigan.gov

Revised December 2022

CAREWare Reports = Custom Reports = Manage Run Custom Reports = Bui

Mext Back

Help

Last Quantitative Lab Date>Subfilter

The following 3 criteria need completion for the subfilter

1.Lab

viral Load

2. Date Range

Date Option:
==

=

Months

12 Min. menths before end date

0 Max. months before end date

3. Cross-Provider

Yes
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21. Repeat Step 15-16. Select Add. From the list, select Last Quantitative Lab Date. This
will take you to a sub-filter. For Last

Quantitative Lab Date, three fields have to be defined: lab, date range, and

cross-provider.

22. From the dropdown menu, select the Lab (Viral Load), Date Range (12 months), and
Cross-Provider (Yes). Then select Next.

® P CAREWare Reports > Custom Reports > Manage Run Custom Reports > Bui
Add Client Next Back Help

Find Client . . )
Reports Last Quantitative Lab Date>Subfilter
Rapid Entry

Appointments The following 3 criteria need completion for the subfilter
My Settings 1. Lab

System Information B oo

System Messages
Administrative Options
Switch Providers

Log Off

Date Option:

For system issues please contact
us at MDHHS-
CAREWareSupport@michigan.gov

2. Date Range

Months

.12 Min. months before end date

= |0 Mazx. months before end date

3. Cross-Provider

Yes

23.  You can change the column header, set priorities, and change fonts and colors. Once

you do that, select Save.

[ — CAREWare Reports > Custom Reports > Manage Run Custom Reports > Building Custom Report Guide Test > Field Selection :
tomiz
Add Client Save Back
Find Client )
Reports Select Field Setup
Rapid Entry
AR Select Field: |Last Quantitative Lab Date
My Settings Column Header: |Last Quantitative Lab Date
System Information
System M
Note. The “Last Administrative Options
. Switch Providers )
Quantitative Lab | "
Sort Priority: 0
” field i
Date e IS For system issues please contact Header Column Format
us at MDHHS- =
Where dates are CAREWareSupport@michigan.gov Sl T i AR
Column Header Font Name:  Arial
pulled for a lot of soia:
. . Italic:
tests including

CD4 and Viral
Load.

Revised December 2022

Font Size: 8

Font Color: Black
Data Column Format
Font Name: |Arial

Bold:

Italic:
Underiine:
Font Size: &

Font Color:  Black

oo

Field Justification: |Left
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24.

25.

26.

27.

A summary of your field selection appears. You can view your field selection or make
any edits by clicking the blue link. Once you are done, select Back. This will take you
back to the field selection page.

@ Citong CAREWare Reports > Custom Reports > Manage Run Custom Reports > Building Custom Report Guide Test > Field Selection
ustomize

Add Client Back

Find Client

REgoss ®Last Quantitative Lab Date

Rapid Entry

Appointments

My Settings View Select Field Last Quantitative Lab Date; Demographics
System Information

System Messages

Lab = Viral Load Date Range Between 12 AND 0 months before the end date or as of date

Administrative Options Subliter (12/31/2017 And 12/31/2018). AND Cross Provider = Yes
Switch Providers
Log Off Date Format No formatting chosen

Repeat Step 15-16. Select Add. From the list, select Last Quantitative Lab Value.
This will take you to a sub-filter. For Last Quantitative Lab Value, three fields have to
be defined: lab, date range, and cross-provider.

Repeat Step 22-24. From the dropdown menu, select the Lab (Viral Load), Date Range
(12 months), and Cross-Provider (Yes). Then Select Next, Save, and Back.

This is what your filter should look like.

@ X CAREWare Reports > Custom Reports > Manage Run Custom Reports > Buildir
Customize
Add Client Mext Back Help
Find Client
Reports Last Quantitative Lab Value>Subfilter
Rapid Entry
Appointments The following 3 criteria need completion for the subfilter
My Settings 1. Lab
System Ir?formatlun B ol Load
System Messages
Administrative Options 2. Date Range
Swileil rovider= Date Option: |Months
Log Off
==: 12 Min. months before end date
==: |0 Max. months before end date
F rst iss I tact =
S e 3. Cross-Provider
CAREWareSupport@michigan.gov = "r’eé| '

@ T CAREWare Reports > Custom Reports > Manage Run Custom Reports > Building Custom Report Guide Test > Field Selection >
Add Client Save Back

Find Client

Reports Select Field Setup

Rapid Entry

Appointmenis Select Field: |Last Quantitative Lab Value

My Settings Column Header: |Last Quantitative Lab Valueg|

System Information

System Messages

Administrative Options

Switch Providers §

Log Off Sort:
Sort Priority: 0

| ) Header Column Format
“or system iszues please contact
S-

is at MDHH: i = i
Column Width: 0.55 inches
CAREWareSuppori@michigan. gov
Column Header Font Name: Arial [ & ]
Bold:
Italic:

Underline:
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28.

29.

You can add additional field selections if necessary. If you don’t need to add any
additional filters, then this is what the final product will look like. Select Back to run your
report. This is what the field selection will look like once all fields are added.

9 Customize

CAREWare Reports » Custom Reports » Manage Run Custom Reports » Building Custom Report Guide Test> Field Selection

Add Client Manage Add MoveUp MoveDown Delete Templates Back  Print or Export
Find Client . .
Repors Field Selection
Rapid Entry el
Appointments
My Settings Field Name Column Header Column Width (in) Totals Sort Sort Priority Status
System Information elURN elURN 120 0 Complete
System Messages RacelEthnicity RacelEthnicity 144 0 Complete
Administrative Opti

DRSS Last Quanttative Lab Date  Last Quanttative Lab Di 058 0 Complete
Switch Providers
Log Of Last Quantitative Lab Value Last Quantitative Lab Ve 0.55 0 Complete

For system issues please contact
us at MDHHS-
CAREWareSupporti@michigan.gov

It is time to run your report. Click Run Report.

@ Custormize CAREWare Reports > Custom Reports > Manage Run Custom Reporis » Building Custom Report Guide Test

Add Client Back

Find Client

Reports @®Building Custom Report Guide Test

Rapid Entry

Appointments ; : _ :

My Settings Run Report gt:; ?ﬁtséﬁu{m?g\l&, End Date : 12/31/2018, Clients with services, Report Display as :

System Information
System Messages
Administrative Options

Report Layout

Switch Providers
Log Off Field Selection

Repaort Filter
For system issues please contact

us at MDHHS-
CAREWareSupport@michigan.gov
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Building Custom Report Guide Test, Demographics

ellRN, Race/Ethnicity, Last Quantitative Lab Date, Last Quantitative Lab Value

Subservice count by funding in date span { Funding Source = Part A Date Span (optional)
Between 12 AND 0 months before the end date or as of date (12/31/2017 And 12/31/2018).
AND Cross-Provider = No ) >=1
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30. Click Edit. Specify the timespan and output display. Then Save.

@ Sk CAREWare Reports > Custom Reports > Manage Run Custom Reports * Building Custom Report Guide Test > Run Report > Edit
ustomize

Add Client Save Cancel

Find Client

Reports Run Report
Rapid Entry

Appointments Parameters

My Setings Date From: |1/1/2012 £
Ejystenj Irjfor_njatlon Date Through: |12/31/2018 _‘I
System Messages
Administrative Options Clinical Review Year:
Switch Providers

OQutput Display: |Open as PDF
Log Off

Show New Clients only:

Show Clients with Service only: ¥

ES r;sﬁ?mgs:ues e toac Show Specifications:

4 -
CAREWareSuppori@michigan.gov Som Numads Fekls:

Domain Sharing Settings

Show Shared Service Records: ¥

Show Shared Clinical Records: ¥

Show Shared Custom Subform Records:

Show Shared Case Notes:

Note: For Output Display, you have three options: open as PDF, download as CSV, or
open in new window. If you want to export it to excel, then you should download it
as a CSV. If you just want to just view the results, then you should either open it as
a PDF or open in a new window.

Make sure Show Clients with Services Only, Show Shared Service Records,
and Show Shared Clinical Records is always checked. You will get more
comprehensive data.
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31.

32.

33.

34.

Select Run Report.

@ Customize
Add Client

Find Client
Reports

Rapid Entry
Appointments

My Settings
System Information
System Messages
Administrative Options
Switch Providers
Log Off

For system issues please contact
us at MDHHS-
CAREWareSupport@michigan.gov

want to see that box.

CAREWare Reports > Custom Reports >

Edit Run Report Back

Run Report

Date From:

Date Through:

Clinical Review Year:

Qutput Display:

Show New Clients only:

Show Clients with Service only:
Show Specifications:

Sum Mumeric Fields:

Show Shared Service Records:
Show Shared Clinical Records:
Show Shared Custom Subform Records:

Show Shared Case Notes:

Manage Run Custom Reports > Building Custom Re

Parameters
112018

12131/2018

Open as PDF

Domain Sharing Settings

On the right-hand side, you will see a box that lets you know the report is running. You

Report is initiated

Once it generates, you will receive a message that lets you know it is completed. It will
also be on the right-hand side. Click View Building Custom Report Guide Test.

The report should look like this

Revised December 2022

. Report generation complete.

View Building Custom Report
Guide Test
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Building Custom Report Guide Test

Data Scope:
Report Start Date:
Report End Date:

eURN:

MLEEWLIN
EHNON TTA,
ougw EuT78
diodiS4Ank
LjrdeRLMm
12BzZtoFa
CHOGAOEM
Crpazeslk
bZs TgAmPu
VLinkw tfed
PrBzzbEyx
JThiw+BEDT
meHla2ZF
Beigv OGP
w GUSZSPm
SDhxbFygX
UPELy KEKY

JYhlg?GD

Matrix Human Services

o1/a1/2018
12/31/2018

RaceEthnicity:

White (non-His panic |
White (non-Hspanic )
Black or Afrcan-Amercan
Hipanic

White (non-Hspanic )
White (non-His panic |
White (ron-Hspanic )
Black or Afrcan-Amercan
¥White (non-Hspanic
Black or Afrcan-Amercan
Black or African-American
Hepanic

White {ror-Hs panic )
Black or Afrcan-Amercan
White (non-Hepanic )
White (non-Hispanic )
Hipanic

Black or Afrcan-Amercan

Last Last

QLIEIIHIHJUB glﬁlﬂ...
£

1 mbk Mls - I
MO22ME 20

08292018 20
11152018 20
10T 2 E 20
09182me 20
111092018 20
102212018 20
10/302ME 20
OF w208 20
09202018 20
112018 20

09272018 20

09262018 20
12018 20
08292018 20

1016208 20

Note: Creating a report using a “PDF” or “Open new window” output opens the report in
a new tab. In order to get back to CAREWare, close out the tab. That will take you
back to the run report page
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GoTo Top of the Document

Page 67



CAREWare: Export into Excel

Once you have a report, you can easily export the information into excel.

1. On the run report page, you choose the parameters for you report. This includes the
date parameters and output. To export, you want to choose Download as CSV as your
output. Then Save.

@ c . CAREWare Reports > Custom Reports > Manage Run Custom Reports > Building Custom Report Guide
ustomize

Add Client Save Cancel

Find Client

Reports Run Report
Rapid Entry

Appointments

SERILE Date From: |1/1/2018
System Information

System Messages

Parameters

Date Through: |12/31/2018

Administrative Options Clinical Review Year:
Switeh Providers Output Display: |Download as CSV
Log Off

Show New Clients only:
Show Clients with Service only: ¢

Eg;?ﬁt[;:nHlsSs:ues please contact Show Specifications:

CAREWareSupport@michigan.gov Sum Numeric Fiekls:
Domain Sharing_Settings

Show Shared Service Records:

Show Shared Clinical Records:

Show Shared Custom Subform Records:

Show Shared Case Notes:

2. Click Run Report. You will get a message
that lets you know the export is
generating (on the right-hand side).

@ Export is initiated

3. Once it generates, you will be () [

prompted to download the report. . sy
>S5V export generation is now
complete.

Download Building Cuostom Report
Guide Test
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Microsoft Excel Tips

Import Errors

Once you have exported your data into excel, you may see green triangles in the top, left-
hand corner of the data cells that look like this:

A B C D = - G 4 | J K
Name Gender Age HIV Risk F&Race/Ethnicity HH Income Last Prima Last Quant Last Quantitative Lab Value
Daffy Duck Male 0 MSM Black or African-America\, 8796.0000 Medicaid 5/26/2016 '358

Mickey Mouse Male 36 MSM Black or Afiican-American.0000  Medicaid  10/10/2016 29403

Tom Cat Male 14 MSM Black or African-American '0.0000 Private - Em 12/1/2016 76262

Donald Duck Male 53 Heterosexu: Black or Afican-American '0.0000  Medicaid  12/28/2016 13660

Pepe Le Pew Female 23 Heterosexu: Black or African-American '0.0000  Medicaid 8/16/2016 23522

Yogi Bear Male 10 MSM White (non-Hispanic) ~ 0.0000  Medicare P;11/3/2016 42305

These sometimes occur when excel doesn’t read the

. . . HH |
numbers as numbers. To resolve this, highlight the —— '3?95"55)[;39
entire column and a yellow warning box will appear. 0 0000
Click on that, and then select Convert to Number. 0.0000
0.0000
0.0000
00000 |
A B C D E
You may also need to convert your dates 1 eURN Rac?,fEthr Last Quan Last Quantitative
2 MUzEWU» White (no 1/2/2018 20
3 |iDINOVTTT *._"3& ........ 20
4 |ougqwEuT: Black or A ##HHHE 20
1. To convert #### to dates, highlight i ca 7 X
the COIl'Imn' Mumber  Alignment Font Border Fill Protection
2. Right-click the column and choose Categony:
Format Cells. Ceneral sele
Currengy Last Quantitative Lab Date
3. Under the Number tab, choose Currengy e
Date. E_Time *3/14/2012 ~
Percentage *\:Vednesday, March 14, 2012
4. Choose the date format you would Fracton e
i e
like to use. T Ta-Nior
5' SeleCt Okay Custom I__:Ji-ahlla[rljczation]: :
6. You will be redirected back to the English (United States] v
excel sheet and the dates will
appear.
Date formats display date and time serial numbers as date values. Date formats that begin with
an asterisk (*] respond to changes in regional date and time settings that are specified for the
operating system. Formats without an asterisk are not affected by operating system settings.
Cancel
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Sorting Your Data

N
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW Sheena Ka
- = Y
% cut v o Jxw = S Wrop Tex General Good Neutral 8= By Zaeemc Ay g
P; & Copy - Ny z I Delete F F‘”' Sort & Find &
g NP : oot Delte Format ¢
T Sromatpaimes B T Y- E - DA b % orv-- R reccer [ o T e e ser
Clipboard ] Font Number ] Styles Cells Editing
S11 - e
A B c D E F G H | J K L M N o P Q R S T u v w X
Last Primary Viral Load  Viral Load
1 Name Gender Age HIV Risk Factor Race/Ethnicity HH Income Insurance In Span  Lab Date Lab Value
2 |Daffy Duck Male 30 MSM Black or African-American 8796 Medicaid 56/26/2016 858
3 |Mickey Mouse Male 36 MSM Black or African-American 0 Medicaid 10/10/2016 29403
4 [Tom Cat Male 44 MSM Black or African-American 0 Private - Employer 12/1/2016 76262
5 |Donald Duck  Male 53 Black or Afri i 0 Medicaid 12/28/2016 13660
6 |PepelePew Female 23t Black or Afri 0 Medicaid 8/16/2016 23522
7 Yogi Bear Male 40 MSM White (non-Hispanic) 0 Medicare Part A/B 17372016 42305
8
9

1. Highlight all cells and select Sort & Filter.
From the dropdown menu, select “Custom Sort”.
A sort box will appear from the dropdown menu. Select the column you would like to “sort by.” In the
order box, you can decide if you would like to list the numbers largest to smallest or vice versa.

. N
Sort | 22|
[ +§lgdd Level ” }(Qelete Level H EE] Copy Level ” My data has headers
Column Sort On Order

e—_—— ]
P Sort by |viral Load Lab Value IZ‘ Yalues IZ‘ Smallest to Largest IZ‘

OK ] [ Cancel

For this example, largest to smallest was used so you can easily pick out the individuals with
the highest viral load as they have the highest risk for poor health outcomes.

A | B % D [ E . E | G | H | [

Last Primary Viral Load Viral Load
Name Gender Age HIV Risk Factor Race/Ethnicity HH Income Insurance In Span Lab Date Lab Value
Tom Cat Male 44 MSM Black or African-American 0 Private - Employer 12/1/2016 76262
|Yogi Bear Male 40 MSM White (non-Hispanic) 0 Medicare Part A/B 11/3/2016 42305
|Mickey Mouse Male 36 MSM Black or African-American 0 Medicaid 10/10/2016 29403
|Pepe Le Pew Female 23 Heterosexual Black or African-American 0 Medicaid B8/16/2016 23522
Donald Duck  Male 53 Heterosexual Black or African-American 0 Medicaid 12/28/2016 13660
|Daffy Duck Male 30 MSM Black or African-American 8796 Medicaid 5/26/2016 858

[ e TR e R TR = S T o R
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Generating RSR Reports in CAREWare

This guide will walk you through the process of creating and running a RSR report in
CAREWare. This includes:

e Guide on how to run a “Client Report Viewer” Report

This report allows users to view all client data being reported on the RSR. It also
allows users to easily find clients and adjust any incorrect or missing clinical data.

Note: After you update client information, you must create a new report to
reflect those changes.

e Guide on how to run a “Data Validation” Report

Creates a list of missing RSR related data and gives access to the list of clients who
are missing this data.
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Creating and Running the “Client Report Viewer” Report

1. From the main page, click Reports.

2. Select HRSA Reports.

@ Customize
Add Client

Find Client

Reports

Rapid Entry
Appointments

My Settings
System Information
System Messages
Administrative Options
External Links
Switch Providers
Log Off

This is a test notification

Don't forget to contact the
helpdesk if you would like to
schedule an appointment to

receive assistance upgrading to

CAREWare 6.

CAREWare Reports

HRSA Reports

Custom Reports

Performance Measures

Client Data Reports

Financial Report

Administrative Reports

Permission Reports

RDR

3. Select RSR Client Report.

Revised December 2022

@ Customize
Add Client

Find Client
Reports

Rapid Entry
Appointments

My Settings
System Information
System Messages
Administrative Options
External Links
Switch Providers
Log Off

This is a test notification

Don't forget to contact the
helpdesk if you would like to
schedule an appointment to

@CAREWare Reports

RSR and ADR

Run or manage custom reports

Run or Manage Performance Measures

Run reports on client information

Setup and run the financial report

Administrative reports and options

Run and search permissons held by a user at a point in time

Manage/Run the RDR

CAREWare Reports > HRSA Reports
Help Back

@HRSA Reports

RSR Client Report Create the RSR client level data file

RSR Viewer View RSR files

RSR Validation Report View the RSR Validation Report

ADR Client Export Create the ADR Client Export

ADR Viewer View ADR files

ADR Validation Report View the ADR Validation Report

receive assistance upgrading to

CAREWare 6.
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4. This is the main RSR page. Make sure the report year is set to the year in which you want

to run the report. Select Edit to change the year of the report.

@ Customize
Add Client

Find Client
Reports

Rapid Entry
Appointments

My Settings
System Information
System Messages
Administrative Options
External Links

CAREWare Reports > HRSA Reports > RSR Settings
Edit EditFiter Run Help Back

RSR Settings

Year: (2019
Cross Provider Labs:
Cross Provider ART:

Apply Filter:

Filter Description:

Report Filter is empty

Switch Providers
Log Off

This is a test notification

Note: You always want to make sure Cross Provider Labs & Cross Provider ART is
selected. There is no need to add a filter because you never want to filter out clients
when submitting the RSR.

5. Once you make those changes, click Save.

@ i CAREWare Reports > HRSA Reports > RSR Settings
Customize

Add Client Save Cancel

Find Client )

Reports RSR Settings

Rapid Entry

Appointments Year: (2019
My Settings Cross Provider Labs: ¥

System Information
System Messages
Administrative Options Apply Filter:
External Links

Cross Provider ART: &

Filter Description: |Report Filter is empty
Switch Providers

Log Off

This is a test notification

6. Select Run.

@ i CAREWare Reports > HRSA Reports > RSR Settings
Customize

Add Client Edit EditFiter Run Help Back

Find Client .

Reports RSR Settings

Rapid Entry

Appointments Year: 2019

My Settings Cross Provider Labs:

System Information

System Messages

Administrative Options Apply Filter:
External Links
Switch Providers
Log Off

Cross Provider ART:

Filter Description: |Report Filter is empty

This is a test notification
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7. On the right-hand side, you will see a box that
lets you know the report is running. It will say

“CO”eCtlng SerVICG Data” @ Collecting service data: Outreach

Services

8. Once it generates, you will receive a message
that says Report Complete (also on the right-
hand side). Select Download RSR [le. It will
download as a CSV file.

. Report complete

Download RSR file

9. Once the report downloads, click the Back button to get back to the main RSR page.

@ i CAREWare Reports > HRSA Reports » RSR Settings
Customize

Add Client Edit EditFiter Run Help Back

Find Client

Reports RSR Settings

Rapid Entry

Appointments Year: [2019

My Settings Cross Provider Labs:

System Information

System Messages

Administrative Options Apply Filter:
External Links
Switch Providers
Log Off

Cross Provider ART:

Filter Description: |Report Filter is empty

This is a test notification

10. Select RSR Viewer. The RSR Viewer will show you the results of that exported file. It
will include demographical, service, and lab information for all your clients and is
broken into those categories. It will also tell you any missing data you may have.

@ i CAREWare Reports > HRSA Reports

Customize

Add Client Help  Back

Find Client

Repors ®HRSA Reports

Rapid Entry

Appointments

My Settings RSR Client Report Create the RSR client level data file

System Information
System Messages

RSR Viewer View RSR files

Administrative Options J

External Links

Switch Providers RSR Validation Report View the RSR Validation Report

Log Off

ADR Client Export Create the ADR Client Export

This is a test notification ADR Viewer View ADR files
Don't forget to contact the ADR Validation Report View the ADR Validation Report

helpdesk if you would like to
schedule an appointment fo
receive assistance upgrading to
CAREWare 6.
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11. Choose the CSV file you just downloaded and then select View RSR File.

@ Customize

CAREWare Reports > HRSA Reports > RSR Viewer

Choose File | RSR_Export (2).xml

Add Client View RSR File Help Back
Find Client

Reports RSR Viewer

Rapid Entry

Appointments RSR File Name: | Choose File |

My Settings

Systemn Information
Systern Messages
Administrative Options
External Links

Switch Providers

Log Off

12. This is what your RSR file should look like.

Note: You want to pay
attention to any
missing
information. If there
is @ number next to
the Missing
category, it means
you have missing
records. If it says
zero, then there
are no missing
records.

Revised December 2022

@ Customize
Add Client

Find Client
Reports

Rapid Entry
Appointments

My Settings
System Information
System Messages
Administrative Options
External Links
Switch Providers
Log Off

This is a test notification

Don't forget to contact the
helpdesk if you would like to
schedule an appointment to

receive assistance upgrading to

CAREWare 6

Upload Completed Successfully. {7.69 KB of 7.69 KB)

CAREWare Reports > HRSA Reports > RSR Viewer > State of Michigan 2019 RSR

View Client List  Back

Print or Export

State of Michigan

2019 RSR

Search

Category Count Percent
Total Clients (any service): 10 100%
Clients with Core Medical/CM services: 8 80.0%
Clients with OAHS/CM/Housing services: B 60.0%
Clients with OAHS/CM services: 6 60.0%
Clients with OAHS services: 2 20.0%
HIV+ Clients with QAHS: 1 10.0%
Female HIV+ Clients with OAHS: 1 10.0%
2. Vital Status (ODAHS/CM) [}

2. Alive: B 100.0%
2. Deceased 0 0.0%
2. Unknown: 0 0.0%
2. Missing: 0 0.0%
4. Birth Year (All clients) 10

4. 1960 and before: 3 30.0%
4.1961 - 1970 2 20.0%
4.1971 - 1980 0 0.0%
4.1981 - 1990 4 40.0%
4.1991 - 2000: 0 0.0%
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13. To view your missing records, simply select the box and then select View Client List.

@ Customize
Add Client

Find Client
Reports

Rapid Entry
Appointments

My Settings
Systemn Information
Systemn Messages
Administrative Options
External Links
Switch Providers
Log Off

This is a test notification

Don't forget to contact the
helpdesk if you would like to
schedule an appointment to
receive assistance upgrading to
CAREWare 6.

CAREWare Reports » HRSA Reports » RSR Viewer » State of Michigan 2019 RSR

View Client List Back Print or Export

State of Michigan

2019 RSR

Search:

Category
. Female
. Transgender MiF:
. Transgender FM:

7

7

7

7. Transgender Other:
7. Unknown:

7

. Missing:

Poverty Level % (OAHS/CM)
Below 100% FPL:

100 - 138%:

139 - 200%:

201 - 250%:

251 - 400%:

401 - 500%:

More than 500%:

© v © © Lo O O Lo O

Missing:

10. Housing Status (OQAHS/CM/Housing)

10. Stable/Permanent:
10. Temporary:

Count

o o o o o &

Percent
40.0%
0.0%
0.0%
0.0%
0.0%
0.0%

16.7%
0.0%
33.3%
0.0%
33.3%
0.0%
0.0%
16.7%

66.7%
0.0%

14. A list of the clients will appear. From there, you can select a client and go to their

individual record. Click Go to Client.

@ Customize
Add Client

Find Client

Reports

Rapid Entry
Appointments

My Settings
System Information
System Messages
Administrative Options
External Links
Switch Providers
Log Off

Revised December 2022

CAREWare Reports > HRSA Reports » RSR Viewer > State of Michigan 2019 RSR > 9. Missing:

Go To Client Back

9. Missing:

Search:

F

Client

June, Jen

Print or Export
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15. The client record will open up in a separate tab. Select the field in which information
needs to be added. When you are done adding all of the missing information, close out
of the client record.

Demographics
Client Report
Encounter Report
Drug Payments
Services

Annual Review
Case Notes

Custom Forms

Vital Signs

Hospital Admissions
Medications

Labs

Screenings
Screening Labs
Immunizations
Diagnoses

Sharing Requests
Referrals

Relations
Counseling and Testing
Orders
Appointments

Cap On Charges
User Messages
Search Change Details
Duplicate Client

Performance Measure
status

External Links
Close

Demographics

Delete Client  Back

@®Demographics

Personal Info

Change URN

Caontact Information

Race/Ethnicity

HIV Risk Factors

Vital Enroliment Status

Eligibility

HIV Status

Common Motes

Provider Motes

Mame: Hemsworth, Chris Gender: Male DOB: 02/12/1937

CRHMO0212871U

2799 W. Grand Blvd
Detroit , MI 43208

‘White

IDU, Heterosexual

Vital Status: Alive Current Status: Active

Ryan White Eligible

HIV-positive (AIDS status unknown) Estimated HIV Date: 10/01/2017

THIS IS SOMETHING YOU WANT ANYONE TO KNOW

PREFERRED NAME
ADDRESS CHANGE

No description supplied

16. After closing, you will be taken back to the Missing client page. Follow step 14-15 for
the next client on the list. Continue to do this until your list is empty.
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Running Data Validation Reports

1. From the main page, click Reports.
2. Select HRSA Reports.

@ . CAREWare Reports
Customize

Add Client

Find Client @CAREWare Reports

Reports

Rapid Entry

Appointments HRSA Reports . RSR and ADR

My Settings

System Information Custom Reports Run or manage custom reports

System Messages

AdI'I'IIﬂIStI'E-tI‘.I'E Options Periormance Measures Run or Manage Performance Measures

External Links

Switch Providers

Log Off Client Data Reports Run reports on client information

Financial Report Setup and run the financial report
This is a test notification
Administrative Reports Administrative reports and options
Don't forget to contact the
helpdesk if you would like to — . e
schedule an appointment to Permission Reports Run and search permissons held by a user at a point in time
receive assistance upgrading to
CAREWare 6.
RDR Manage/Run the RDR

3. Select RSR Validation Report.

@ 5 CAREWare Reports > HRSA Reports

Customize

Add Client Help Back

Find Client

Reports @®HRSA Reports

Rapid Entry

Appointments

My Settings RSR Client Report Create the RSR client level data file

System Information
System Messages

RSR Viewer View RSR files

Administrative Options

External Links

Switch Providers RSR Validation Report View the RSR Validation Report

Log Off ' '

ADR Client Export Create the ADR Client Export

This is a test notification ADR Viewer View ADR files
Don't forget to contact the ADR Validation Report View the ADR Validation Report

helpdesk if you would like to
schedule an appointment to
receive assistance upgrading to
CAREWare 6.
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4. Select Edit

@ Customize
Add Client

Find Client
Reports

Rapid Entry
Appointments

My Settings
System Information
Systemn Messages
Administrative Options
External Links
Switch Providers
Log Off

This is a test notification

Don't forget to contact the
helpdesk if you would like to
schedule an appointment to

receive assistance upgrading to

CAREWare 6.

CAREWare Reports > HRSA Reports » RSR Validation Report Settings
Edit Edit Filter Filter By Funding Source Run  Help Back

RSR Validation Report Settings

Year: (2019
Cross Provider Labs:
Cross Provider ART:
Apply Filter:

Filter Description: |Report Filter is empty

Note: You are given three editing options: Edit, Edit Filter, & Filter by Funding Source. In
general, Edit is the one you will choose. However, if you ever want to apply a filter or
if you receive funding from multiple sources and want to filter by each funding source,
you have the option to edit by those criteria too.

5. After selecting edit, choose the Year you would like to review. Additionally, make sure you
check Cross Provider Labs & Cross Provider ART.

6. Save

@ Customize
Add Client

Find Client
Reports

Rapid Entry
Appointments

My Settings
System Information
System Messages
Administrative Options
External Links
Switch Providers
Log Off

This is a test notification

Revised December 2022

CAREWare Reports > HRSA Reports > RSR Validation Report Settings

Save Cancel

RSR Validation Report Settings
Year: |2019

Cross Provider Labs: ¢
Cross Provider ART: |+
Apply Filter:

Filter Description: |Report Filter is empty
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7. Once you save, you can run your report. Select Run.

@ Customize
Add Client

Find Client
Reports

Rapid Entry
Appointments

My Settings
System Information
System Messages
Administrative Options
External Links
Switch Providers
Log Off

This is a test notification

CAREWare Reports > HRSA Reports » RSR Validation Report Settings
Edit EditFilter Filter By Funding Source  Run Help Back

RSR Validation Report Settings

Year:

Cross Provider Labs:
Cross Provider ART:
Apply Filter:

Filter Description:

2019

o

Report Filter is empty

8. On the right-hand side, you will see a — ®

box that lets you know the report is
running. It will say “Collecting Service

Data.”

Once it generates, you will receive a
message that says the Complete

(also on the right-hand side). Select
View RSR Validation Report. It will

download as a CSV file.

Revised December 2022

@ Collecting service data- Qutreach

Services

. Report complete

View RSR Validation Report
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10. This is your validation report.

@ e CAREWare Reports > HRSA Reports > RSR Validation Report Settings > RSR Validation Report
Add Client Viiew Client List Back Print or Export
e RSR Validation Report
Rapid Entry SemeT
Appointments
My Settings Category Validation Rule Severity # Errors
System Information Demographics Clients with Birth Year after end of reportini. Error 0
83"51'.3”_1 Me?sagesl Demographics Clients with Birth Year after First HIV Outp: Error 0
’;::;'r:'::ﬁ:‘z Options Demographics Clients with HIVIAIDS Status of Indetermin Warning 0
Switch Providers Demographics Clients with Male or Unknown Gender with Alert 0
Log Off Demographics Clients with HIV diagnosis year after report Alert 0
Demographics Clients with Male or Unknown Gender with  Alert 0
Demographics Clients age 80 or older Alert 0
IS Pk nONREon) Demographics Clients with Birth Year after HIV diagnosis 1 Alert 0
Demegraphics Clients with Birth Year after CD4 Test Date: Alert 0
Don't forget to contact the Demographics Clients with Birth Year after Qutpatient/Amit Alert 0
e Demographics Clients with Birth Year after Viral Load Test Alert 0
gg?{'g\;ﬁg'ﬁa”w upgrading to Demographics Clients missing Poverty Level Waming 2
Demographics Clients missing Housing Status Waming 7
Demographics Clients missing Medical Insurance Warning L}
Demographics Clients with HIV/AIDS Status of Indetermin Warmning 0
Services Clients missing Core Medical or Support S Warning 0
Services Clients with Qutpatient'Ambulatory Medica Alert 0
Services Service Visits Exceed Yearly Limit Alert 0
Services Clients with Core Medical Services with HI' Warning 1
Services Clients with Qutpatient'Ambulatory Medica Error 0

Note: The Severity column is important. There are three options: alert, warning, and error.
You cannot submit an RSR if an error exists; therefore, if the severity column says “error”
with a number displayed in the error’'s column, you must correct the missing data. If the
column says “warning,” you will be able to submit the report but will need to provide an
explanation as to why the information is missing. “Alert” just means that it is something you
should look at, but there are no penalties.

GoTo Top of the Document

Revised December 2022 Page 81



11. The errors column shows the number of clients missing information in the Validation Rule
data field. Click the field with the errors and select View Client List

s > HASA Reports » RSR Validation Repon Setlings > RER Validation Repon

Back  Prisd of Expont

RSR Validation Report

Seach

= Validation Aule Soverdy L3
Demographics CRants with Enth Year after and ol reporiing peniod Emar

Demographas Chents wilh Exth Year after First HIV Ouwipafent AmSulaiory  Emor -]
Demographacs: Clants with HIVOU DS States of indeferminals missing Rsk | YWarming a
Demograghcs Chants with Maks o Uninown Gonder with a Conical Fap S Alert ]
Diorm e Bphucs: Changs with HIV dagnos year wbor ieporbng pansd Adert -]
Demograghics CHants with Mabe of Usimown Geedier with Pragnancy Staly Al [
DB oy CHares age B0 or alde Akt [-]
Disagrahy Chanti with Brth Yt 3067 WV SuAsiH vhdd Al [}
Chemograches: Clras with Barih Year afer GO Tead Dates L -]
Demographss Chants with Brth YVear after Oulpabent'Ambutatony MeBcal { Alert L]
Demagraphics: CHants with Erth Year afier Viral Load Test Dales At -]
Demographics CHants missing Povesty Lavel Warming z
Demographas Chants missing Housing Siahes Warmarg T
Drmographics: Clants missing Madcal inswrancy Varmare 5
Demograghics Clanss with HVIAIDS States of Indederminade Ovier ADE 2 'Waarming [}
Sarvces gy migging Cong Mol o Supporn Servioes Wigrmarey [}
Sarvioei Clpnty with Ouigaitsrd’Ambulaiony Medical Can Service ¥is Alem -}
Sarnoi Sefvice Viats Exomed Yl Limd L [}
Sarncai Chants with Cong Medical Servicad with HIV Hegalive HIVA Wirsing 1
Tt Charas with DuipaisntAmbutaton Medcal Tam Service Do Emar -]

12. A list of clients with missing information will appear. Select the client you would like to view,
and then select Go to Client.

@ el CAREWare Reports > HRSA Reports » RSR Validation Report Seftings > RSR Validation Report =
Add Client Go To Client Back Print or Export

Find Client = . = .

Reporls Clients missing Housing Status

Rapid Entry Ssarch.‘|

Appointments "

My Settings Client Viewed

System Information Mouse, Mincly

Systern Messages Client Test

Administrative Options

i Test-Person, My
External Links

Switch Providers Hemsworth, Chris

Log Off Allen, Barry Flash

Hemsworth, Chris

June, Jen
This is a test notification

Don't forget to contact the
helpdesk if you would like to
schedule an appointment to
receive assistance upgrading fo
CAREWare 6.
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13. The client record will open up in a separate tab. Select the field in which information needs

to be added. When you are done adding all of the missing information, close out of the

clientrecord.

Demographics
Client Report
Encounter Report
Drug Payments
Semvices

Annual Review
Case Notes

Custom Forms

Vital Signs

Hospital Admissions
Medications

Labs

Screenings
Screening Labs
Immunizations
Diagnoses

Sharing Requests
Referrals

Relations
Counseling and Testing
Orders
Appointments

Cap On Charges
User Messages
Search Change Details
Duplicate Client

Performance Measure
Status

External Links

Demographics

Delete Client Back
®Demographics

Personal Info

Change URN

Contact Information

Race/Ethnicity

HIV Risk Factors

Vital Enroliment Status

Eligibility

HIV Status

Common Notes

Name: Hemsworth, Chris Gender: Male DOB: 02/12/1987

CRHMO0212871U

2799 W. Grand Blvd
Detroit , MI 43208

White

IDU, Heterosexual

Vital Status: Alive Current Status: Active

Ryan White Eligible

HIV-positive (AIDS status unknown) Estimated HIV Date: 10/01/2017

THIS IS SOMETHING YOU WANT ANYONE TO KNOW
PREFERRED NAME

ADDRESS CHANGE
Close

Provider Nofes No description supplied

14. After closing, you will be taken back to the Missing client page. Follow step 12-13 for the
next client on the list. Continue to do this until your list is empty.

For any questions, please contact MDHHS - Bureau of HIV/STI Programs @
(MDHHS-SHOARS-SUPPORT@michigan.gov).
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